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everal years ago my buddy
Steve died in an avalanche.
It was a stormy day and the

avalanche danger was high, so
Steve and his partners chose a ski
tour they thought would be safe.
They had skied the route many
times before and were confident
that their experience, skill and
avalanche knowledge would keep
them out of trouble that day.
Several hours into their tour, as
they broke trail across a low-angle
slope, they triggered an avalanche
that swept down on them from
above. The avalanche caught all
three of them, breaking one man’s
thigh against a tree and
completely burying Steve. Other
skiers nearby heard the accident
and came to the rescue, but Steve
died before they could dig him
out.

In the aftermath of the
accident, people tried to make
sense of what had happened.
Some claimed that Steve’s death
was the result of foolish risks, but
I knew better. Weeks earlier, I had
shared a lift ride with Steve at
Alta, and we had laughed about

our climbing adventures years
before. Things were different now,
Steve said, and he told me about
his wife and his beautiful four-
y e a r-old daughter. He believed
his days of being reckless were
over, and the time for raising his
family had begun. When he died,
it was on a popular route in
familiar terrain, on a slope
traversed by dozens of people
every season, in a place that he
believed was safe. The foolish risk
story just didn’t seem to fit what I
knew about Steve and the
accident, and I began to suspect
that such stories were really about
something else.

Exactly what these stories
meant became clear to me when I
noticed the striking parallel
between each story and the
perspective of the teller.  The
foolish risk story was often told by
people who prided themselves on
their ability to avoid foolish risks.
A story about the need for better
education often came fro m
educators or science types.

Heuristic Traps in Recreational
Avalanche Accidents:

Evidence and Implications, Part 1

By Ian McCammon

Continues on page 16

The starting zone of this particular avalanche path is unsupported
with large cliffs in the track.  The runout zone is 500 to 750 meters
below." Photo by Paul Laca / snowdynamics.com

editor’s note: This is the first in a two-part series on heuristic traps.
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he calendar aside, my year seems to begin in the
fall.  The anticipation.  The changing colors with
the first dustings of snow.  Fall also brings the time

when we renew bonds and friendships with our
colleagues at preseason meetings and seminars.  The

Association held its annual meeting October 3rd a t
Snowbird, Utah.  In conjunction with the meeting a two-

day continuing education seminar was held on the 4th

and 5t h.  A A A’s goal has been to provide some
educational opportunities during the fall in between
ISSW years.  In 1997, an explosive workshop was held
and in 1999, an avalanche education workshop.  This
y e a r’s workshop themes were one day of mountain
weather and a day of avalanche education topics.  Those
who attended were treated to interesting and thought
p rovoking presentations and discussions.  Seminar
evaluations were passed out and this information will
help to shape future professional development events.
The primary goals will remain providing state-of-the-art
information at a reasonable price to AAAmembers.  Look
for the next AAA Continuing Education Seminar in the
fall of 2005.

At the Annual Meeting the board pre s e n t e d
information about several activities in which AAAand its
members are involved. A A A and the Explosives
Committee of the National Ski Areas Association are
nearing the completion of materials that will assist ski
patrol training in safe explosives handling for avalanche
control.  This effort is an outgrowth of the traveling
regional explosives handling seminars sponsored by
AAA that visited many western ski areas several winters
ago.  In another major effort the AAA Research and
Standards Awareness Committees are working with the
U.S. Forest Service National Avalanche Center in creating
a U.S. Observation Guidelines and Reporting Standards
for weather, snowpack, and avalanche data.  The
Canadian Avalanche Association has provided invaluable
assistance with both of these activities.  Look for more
about these endeavors in The Avalanche Review, your
source for the latest avalanche information.

AAA will be conducting its bi-annual elections in the
summer of 2004 for Executive Board and Section
Representative officers.  If you are interested in serving

the avalanche community as an AAA Board Member
please contact me.  

I’d like to take this opportunity to acknowledge a
new AAA Life Member, Dave Hendrickson.  Dave has
been an AAAProfessional Member for many years and a
legend in southeast Alaska.  Life membership involves
substantial financial support for AAA.  Thank you, Dave.

Membership and subscription renewal requests went
out this past summer.  Most of you have already renewed.
If you are unsure, check the mailing label of this Avalanche
R e v i e w.  The date indicates when your membership
expires.  If you have any questions do not hesitate to
contact me.  Only members in good standing will be
included in and receive the 2004 A A A M e m b e r s h i p
Directory  

I was sorry to hear recently from Norm Wilson that a
friend and colleague, Nic Kindschi passed away last
August.  He was in his 80’s.  Probably not well known in
the United States, Nic was Chief of the Parsenndienst
(basically the ski patrol), Davos, Switzerland, for many
years until he retired.  The Parsenndienst and Davos are
discussed at length in Colin Fraser’s classic book, The
Avalanche Enigma. Nic was a real mountain person who
spent a lot of time keeping up with the latest innovations
and trying to keep people from getting avalanched.  After
his retirement, he continued to advise the Swiss Army

about avalanche matters and on his 75th birthday he
climbed the Finsteraarhorn- a well known, spectacular,
and not undemanding Swiss summit.

I met Nic at Squaw Valley in 1982, when he was
touring U.S. ski areas with Norm Wilson.  Almost twenty
years later I met Nic again by coincidence at the Jamtal
Hutte in Austria’s Silveretta.  My skill in German had
improved some and we visited.  Nic, with friend and
mountain guide, Walter Berliner offered some much-
needed advice on getting to a group of mountains my
wife and I wanted to ski.  I marveled at these classy
mountain men who were still getting out and about in the
mountains they loved in all seasons.  I look to them as
examples of where I hope to be in my years to come.

By the time you read this, winter will be upon us. I
wish you all a safe and successful winter.  Good luck,
good hunting, and stay on top.       

FROM THE EDITOR: BLASE REARDON

t the A A A education seminar at Snowbird in
October, avalanche educators demonstrated some
remarkable teaching tools, many of which I’ve

appropriated for my classes this winter.  These techniques
are remarkably effective at conveying knowledge about
snow and avalanches.  But recent research suggests that
often it’s not knowledge about snow and avalanches that
people lack when they get into trouble in the backcountry.
Two articles in this issue of The Avalanche Review
highlight this gap.  The Big Chief accident description is a
firsthand account of the difficulties that even experienced,
knowledgeable people have assessing avalanche risk in
the backcountry. And in the issue’s lead article, Ian
McCammon examines behaviors in several hundre d
avalanche accidents; his analysis shows that avalanche
victims, even those with advanced avalanche training,
typically make decisions in the backcountry using
heuristics - rules of thumb - that work well in everyday
life but which ultimately expose people to more risk
when applied in the backcountry.

McCammon’s research has challenging implications
for avalanche education.  If snow and avalanche
knowledge isn’t keeping people out of trouble, then what
does?  Some recent developments, particularly Munter’s
3x3 and reduction methods, address this question with
probabilistic or rule-based methods for decision-making.
These methods provide formal frameworks that minimize
knowledge about snow and avalanches and substitute
behaviors that might reduce a person’s chances of being
caught in a fatal avalanche accident.  It’s an approach
used in health education ads, which don’t detail the
chemistry of cholesterol.  Instead, they tell you to reduce
your chances of heart disease by not smoking, eating less
red meat and exercising regularly.

The approach isn’t new to avalanche education.
Richmond’s Rituals (One at a time, never ski above your
partner, and always have an escape route) are a familiar
ru l e b a s e d rule based approach to decision-making in
avalanche terrain.  But McCammon’s emphasis and
Munter’s methods nonetheless run counter to how I – and

many other educators – have approached avalanche
education over the years.  For years I’ve responded to
students’ requests for rules and definitive answers with
“It depends…”  Like many avalanche professionals, I
hold to Ron Perla’s “tThe only first rule of thumb in
regards to avalanches is that there are no rules of thumb.”

McCammon and Munter, in different ways, argue
that avalanche educators should not resist students’ drive
for rules of thumb.  Everyone – including avalanche
professionals – makes decisions using heuristics.  Their
approaches imply that in light of this fact, we should give
students rules and behaviors that will help them when
they don’t have the experience to cut through data
overload or assess the results of inconsistent stability
tests. We should give people practices to follow when
t h e y ’ re tired or stressed or their group isn’t
communicating well, if at all.  We should re p l a c e
heuristics that work well in freeway traffic with those that
work well when hazard is “Considerable” in the winter
backcountry. And we should teach these things first.  

I am not sure what to make of this yet, much less how
to do it.  Many avalanche educators don’t.  It is by no
means clear that the statistical basis for Munter’s methods
is valid in North America or that his methods will take
hold among North American backcountry riders and
skiers.  And while McCammon’s detailed research is new,
Fesler and Fredston pointed avalanche education towards
human factors on page 1 of Snow Sense long ago.  I’m
pretty sure recent approaches don’t demand abandoning
knowledge-based teaching. They likely entail focusing
classes on cognitive skills as much as snow and avalanche
knowledge.  That means finding memorable heuristics
and rituals as well as ways to demonstrate them in hour-
long awareness classes.  It requires creating exercises that
help students experience the difference between everyday
heuristics and backcountry heuristics so they have useful
tools when they are in the backcountry.  But it also means
less emphasis - and less course time - to on snow
metamorphism, mountain weather, terrain, and beacon
skills – the very things for which many of us have worked
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hard to develop effective teaching
tools.  Though that may be hard to
accept, the point of Perla’s circular
heuristic may be that with
avalanches we need to keep an open
mind and be willing to change our
practices as our knowledge changes.  

The Avalanche Review: it exists
somewhere between peer-reviewed
journals and informal patrol-shack
conversations.  TAR is less a venue
for definitive conclusions;  and more
a forum where avalanche
p rofessionals pose questions and
suggest solutions, usually based on
h a rd-won experience.   For the
publication to be meaningful;
however, it must involve avalanche
professionals across the community.
Whether you are ski patro l l e r,
avalanche forecaster, or backcountry
enthusiast, you continually assess
risk and make tough decisions.  Are
recent developments and re s e a rc h
a ffecting your practices and
operations?  How?  Articles planned
for the next issue of TAR include a
second installment of McCammon’s
research and an informal discussion
of how the growing awareness of
spatial variability is changing
backcountry and operational
practices.  Add to those discussions;
send us photos, an article, a letter to
the editor, ,; share your insight and
help to avalanche pro f e s s i o n a l s
improve merge theory and practice.

At the AAAeducation seminar at
S n o w b i rd in October, avalanche
educators demonstrated some
remarkable teaching tools, many of
which I’ve appropriated for my
classes this winter.  These techniques
a re remarkably effective at
conveying knowledge about snow
and avalanches.  But recent research
suggests that often it’s not
knowledge about snow and
avalanches that people lack when
they get into trouble in the
b a c k c o u n t r y.  Two articles in this
issue of The Avalanche Review
highlight this problem.  The Big
Chief accident description is a
firsthand account of the difficulties
that even experienced,
knowledgeable people have
assessing avalanche risk in the
backcountry. And in the issue’s lead
article, Ian McCammon examines
behaviors in several hundre d
avalanche accidents; his analysis
shows that avalanche victims
typically make decisions in the
backcountry using heuristics - rules
of thumb - that work well in
everyday life but which ultimately
expose people to more risk when
applied in the backcountry.

McCammon’s re s e a rch has
challenging implications for
avalanche education.  If snow and
avalanche knowledge isn’t keeping
people out of trouble, then what
does?  Some recent developments,
particularly Munter’s 3x3 and
reduction methods, address this
question with probabilistic or rule
based methods for decision-making.
These methods provide formal
frameworks that minimize
knowledge about snow and
avalanches and substitute behaviors
that might reduce a person’s chances
of being caught in a fatal avalanche
accident.  It’s an approach used in
health education ads, which don’t
detail the chemistry of cholesterol.
Instead, they tell you to reduce your
chances of heart disease by not
smoking, eating less red meat and
exercising regularly.

The approach isn’t new to avalanche
education.  Richmond’s Rituals (One
at a time, never ski above your
partner, and always have an escape
route) are a familiar rule based
a p p roach to decision-making in
avalanche terrain.  But McCammon’s
emphasis and Munter’s methods
nonetheless run counter to how I –
and many other educators – have
a p p roached avalanche education
over the years.  For years I’ve
responded to students’ requests for
rules and definitive answers with “It
depends…”  Like many avalanche
professionals, I hold to Ron Perla’s
“The only rule of thumb in regards to
avalanches is that there are no rules
of thumb.”

McCammon and Munter, in
different ways, argue that avalanche
educators should not resist students’
drive for rules of thumb.  Everyone –
including avalanche professionals –
makes decisions using heuristics.
Their approaches tell us that in light
of this fact, we should give students
rules and behaviors that will help
them when they don’t have the
experience to cut through data
overload or assess the results of
stability tests; we should give them
practices that they’ll follow when
t h e y ’ re tired or stressed or their
group isn’t communicating well, if at
all.  We should replace heuristics that
work well in freeway traffic with
those that work well in
“Considerable” hazard in the winter
backcountry. And we should teach
these things first.  

I am not sure what to make of
this yet, much less how to do it.  It’s
by no means clear that Munter ’ s
methods are valid in North America
or will take hold among North
American backcountry riders and
skiers.  And while’s McCammon’s
detailed research is new, Fesler and
F redston pointed avalanche
education towards human factors
long ago.  I’m pretty sure re c e n t
approaches don’t mean abandoning
knowledge-based teaching. They
likely mean focusing classes on
cognitive skills as much as snow and
avalanche knowledge.  That means
developing new ways to teach
h a z a rd recognition and risk
assessment for changing audiences.
It means finding memorable
heuristics and rituals and ways to
demonstrate them in hour- l o n g
awareness classes.  It means creating
e x e rcises that help students
experience the diff e rence between
everyday heuristics and backcountry
heuristics so they have useful tools
when they enter the backcountry.

Over the next few issues, The
Avalanche Review will continue
examining how recent developments
affect . 

Among the articles planned for
the next issue of TAR are a second
installment of McCammon’s research
and an informal discussion of how
the growing awareness of spatial
variability is changing backcountry
practices.  For the discussion to be
meaningful, however, it has to
involve avalanche pro f e s s i o n a l s
across the community.  Whether you
are ski patroller, avalanche forecaster,
or backcountry enthusiast, you
continually assess risk and make
tough decisions. Do these ideas and
concepts hit home for you? Let us
know. Ultimately the point of Perla’s
c i rcular heuristic is that with
avalanches we need to keep an open
mind and be willing to change our
practices as our knowledge changes. 
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New Professional Members
Gary Brill Seattle, WA
Doug Driskell Aspen, CO
Clark Fyans Girdwood, AK
Steve House Mazama, WA
Ron Matous Kelly, WY
Ian McCammon Salt Lake City, UT
Carl Skustad Girdwood, AK

New Member Affiliates
Gary Clawson Boise, ID
Kenny Hier Snowmass, CO
Matthew Pierce Ft. Collins, CO
Ben Prichett Crested Butte, CO
Billy Rankin Crested Butte, CO
Ron Rash Basalt, CO
Ilya Storm Cornwall, VT
David Sweet Boulder, CO
Doug Workman Jackson, WY

New AAA Certified Avalanche
Instructors:
Sam Davis Salt Lake City, UT
Jerry Hance Bozeman, MT
Janet Kellam Ketchum, ID

Steve Conger has moved from Boise,
ID to Vancouver, BC to start working
on a Masters Degree in the
Engineering Department at
University of British Columbia.  He
will be working with Dave McClung.

The Avalanche Review:
A Call for Submissions

Seen any good avalanches lately?
Got some gossip for the other snow
nerds out there?
Developing new tools or ideas?
Learn something from an accident
investigation?
Tell us about a particularly tricky
spot of terrain; 
Send photos of a crown, of avalanche
workers plowing roads, thro w i n g
bombs, teaching classes, or digging
holes in the snow;
Pass on some industry news; 

Write it up; send it to us.  T h e
Avalanche Review is only as good as
the material you send.

TAR is accepting articles, stories,
queries, papers, photos.  We can help
if you’re not sure how to write it up.

TAR Deadlines:
Vol. 22, Issue 3 is January 15, 2004
Vol. 22, Issue 4 is March 15, 2004

Send text as .doc or .rtf files.  

Send photos as black and white .jpg
files.  

The Avalanche Review
blase@cyberport.net
C/O Blase Reardon
636 Columbia Ave.
Whitefish, MT 59937
406/862-0812
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Guidelines for Snow,
Weather, and
Avalanche
Observations in the
United States
By Ethan Greene

he American Av a l a n c h e
Association (AAA) has part-
nered with the USDA-Forest

Service National Avalanche Center
(NAC) and the Canadian Avalanche
Association (CAA) to compile a set of
guidelines for making and recording
snow, weather, and avalanche obser-
vations.  The goals of this project are
to:

1. Provide a valuable resource for
avalanche programs in the
United States

2. Encourage common practices for
observing and re c o rding snow,
weather, and avalanche observa-
tions

3. Promote a common language for
avalanche programs in the U.S.
and North America

4. Establish a method of observing
and recording data that can be
used for statistical fore c a s t i n g
techniques and re s e a rch into
s n o w, weather, and avalanche
phenomena.

Last spring the Governing Board
of the American Av a l a n c h e
Association tasked Craig Sterbenz
(AAA Standards Committee Chair)
and Ethan Greene (AAA R e s e a rc h
Committee Chair) with evaluating
the feasibility of this project.  They
assembled a small working gro u p
and approached the National
Avalanche Center and the Canadian
Avalanche Association for assistance.

The Canadian Av a l a n c h e
Association has generously off e re d
their assistance, experience, and
expertise in this project.  Efforts are
being made to create a document that
is similar in structure and practice to
the CAA’s Observation Guidelines and
Recording Standards for We a t h e r,
Snowpack and Avalanches (OGRS), yet
also maintains common practices cur-
rently used by avalanche programs in
the United States.

I presented a very rough draft of
the proposed guidelines at the AAA
and NAC annual meetings in
October.  These groups made some

suggestions, but in general the docu-
ment was received favorably.  The
working group is incorporating the
comments generated from those dis-
cussions and will release a draft ver-
sion of the document by the first of
the year.  The proposed schedule for
completing the new guidelines is as
follows: 

• December 2003 - Draft version of
the guidelines completed

• January 1, 2004 - Public comment
period begins.  During the public
comment period, copies of the
draft version will be available to
all interested parties and com-
ments will be collected.  The
AAA will publish details of how
to obtain a copy and submit com-
ments its web site, www.ameri-
c a n a v a l a n c h e a s s o c i a t i o n . o rg, by
mid-December.

• March 1, 2004 - Public comment
period ends.

• March 2004 - Final version of the
document prepared.

• April 2004 - Final version pre-
sented to the Governing Board of
the American Av a l a n c h e
Association for ratification.

• 2010 - First revision of the guide-
lines, with subsequent revisions
scheduled every five to ten years.

The substantial public comment
period is intended to facilitate the cre-
ation of a useable and accessible doc-
ument.  Although there will be some
limitation on the distribution of this
document, we hope that an open dis-
cussion will improve the quality and
usefulness of the final document.
Please direct any questions or com-
ments on the project or the process to
Mark Mueller, American Avalanche
Association Executive Dire c t o r, at
a a a @ a v a l a n c h e . o rg.  You can also
help by providing us with any good
photographs of weather stations,
snow pits, stability tests, ski cutting,
good study sites, poor study sites,
equipment problems, or anything
else you think we could use.  Please
send hard copies t:o:

Mark Mueller 
P.O. Box 2831 
Pagosa Springs, CO 81147

You can also email them to him at the
address above.

Education Work
Session Report
Continuing Education
Seminar,
AAA Fall Meeting,
Snowbird

hen the AAABoard met last
spring to plan for the fall
seminar, we felt we needed

to include a work session on ways to
i m p rove avalanche education. We
decided that the best ideas would
come from the audience and that we
should pool our collective expertise
rather than present a panel
discussion. 

The session began with an
excellent PowerPoint put together by
Dale Atkins that outlined the problem
using graphs of avalanche statistics.
Dale is working the statistics up for a
future paper, but the most pertinent
changes to summarize for our
purposes were in the distribution of
avalanche deaths among the states,
the activities of the victims, and their
ages. 
• Over the most recent ten years,

from 1993/94 to 2002/03, the five
states with the most fatalities
have shifted to Alaska, Colorado,
Montana, Utah, and Wyoming, 

• The victims in the earlier period
f rom 1950/51to 1992/93 were
primarily backcountry skiers and
climbers, trailed by out of bounds
lift skiers, and
motorists/highway workers and
miscellaneous recreationists (tied
for fourth). Over the more recent
period from 1950/51 to 2002/03,
climbers, backcountry skiers, and
snowmobilers led the list, trailed
by miscellaneous re c re a t i o n i s t s
and out of bounds lift skiers.

• Victims’ ages continued to be
dominated by the 25-29 year old
age group and the 20-24 year
olds, with a second peak in the
35-39 year olds, but perhaps the
most notable shift was a sharp
increase in fatalities in the 15-19
year old group. 

With this introduction, we posed
the key question for avalanche
educators today: 

If we are doing such a good job,
then why are so many people dying?

We began with a discussion of
our target audience, including
whether there are several audiences,
how audiences may have changed,
and whether our curriculum or
approach might be alienating some
audiences.
• The group quickly identified

snowmobilers and snowmobile
guides as a key target audience.
Serving this audience well
re q u i res a big change fro m
traditional skier/climber
oriented teaching. The consensus
is that we are not re a c h i n g
snowmachiners eff e c t i v e l y
enough. The exceptions are areas
w h e re riders have experienced
friends’ deaths, and areas where
guides are seeking training, in
part driven by land management
agencies. 

• The next target group we
identified is younger people in
general, and “skate culture” in
particular, a group often at risk
but frequently alienated by our
traditional approaches and

attitudes. There was bro a d
agreement that young people are
an avalanche education priority
because, not only because of their
exposure at present, but also as a
way to indirectly educate their
p a rents, and to create a new
generation of hopefully more
avalanche-savvy adults. Yo u t h
c u l t u re shifts, re q u i r i n g
educators to constantly develop
new teaching appro a c h e s .
Suggestions included working
t h rough schools and youth
groups, emphasis on fun in our
courses, and actively developing
a positive, respectful attitude
toward young people, including
cultivating immunity to the adult
tendency to put down younger
people’s dress, hairstyles, music,
speech, and choice of ride
whenever it makes us
uncomfortable.

• Snowshoeing’s popularity has
risen sharply, and snowshoers’
fatality numbers have risen as
well. There was not much
discussion, but we speculated
that many new snowshoers
might be casual users who will
respond better to short courses
than to the traditional Level I.

• Snowmachine access skiers,
b o a rders, and climbers were
identified as a new and rapidly
growing group. These folks sled
into the backcountry for the
primary purpose of skiing or
s n o w b o a rding, but often mix
activities and may do as much
snowmobiling as anything else.
They may build a big kicker, then
session it with skis, snowboards,
and their sleds. This represents
another key demographic shift to
multi-sport users who no longer
identify by only one category.
Users may shift their activities or
add new ones, so our teaching
must be broadly inclusive.

• T h e re has been an increase in
accidents involving urban US
visitors to Canada. They are out
of their home area, often without
a guide, lured by hut systems,
favorable exchange rates, and
great snow; but need better skills.

• Our consensus was that we serve
the traditional backcountry users,
skiers in particular, quite well.
There was little discussion, other
than a comment that we might
well drop our level of effort with
this group in favor of outreach to
currently underserved groups.

• Lift access backcountry users are
not a new group, but we noted
that their numbers have grown
sharply, and that this group now
includes more young people. As
well as powder-seekers, many
new users are skate culture riders
who are going out of bounds to
build kickers and practice aerials
they aren’t allowed to do
inbounds, often in avalanche
terrain.

• We felt we need quality
educational programs for
aspiring snow pro f e s s i o n a l s ,
including patrollers and guides.
There was not much discussion,
but there was general agreement
that it is important to train the
next generation of avalanche
specialists.

Research Notes
By Ethan Greene, AAA Research
Committee Chair

ast spring, the Governing Board
of the American Av a l a n c h e
Association awarded the first

Practitioner Research Grant to Chad
Hults.  Chad is a member of the ski
patrol at the Stevens Pass ski area,
Washington.  He will be working
with Jon Andrews (Stevens Pass) and
Dave Engebretson (We s t e r n
Washington University) on a project
entitled: Directional properties of hand
charge air blasts, relative power measured
using minidisk audio recorders.  The
group will study the effects of hand
charge orientation on the blast power
d e l i v e red.  They will conduct
experiments this winter near the
Stevens Pass ski area.  The American
Avalanche Association awarded this
proposal $1000 to purchase a set of
microphones and minidisk recorders.

Chad will use these recording sets to
collect blast power measure m e n t s ; ,
and he will then useuse an audio
analysis package to determine
preferred hand charge orientation.

This fall, the A A A a w a rded a
Graduate Research Grant to Simon
Trautman for his proposal entitled:
Investigations of wet snow stability in the
intermountain climate zone.  Simon is a
graduate student in the Earth Science
Department at Montana State
University working with Dr. Steven
C u s t e r.  The American Av a l a n c h e
Association awarded $1000 and the
use of a Campbell Scientific 21x data
logger to this project.  Simon will use
the funds to build an instrument that
measures creep within the snowpack
and air temperature.  He hopes to
find a correlation between expects the
data collected with this instrument
and to show a correlation between
creep rates and wet snow avalanche
activity.
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• We agreed that we need training
for industry and transportation
workers to deal with on-the-job
e x p o s u re in power plant,
h i g h w a y, railroad, mining,
logging, and similar operations.

• Climbers remain a high-fatality
group, despite years of including
them as a target group. Many
avalanche specialists are very ski
oriented. Climbers’ needs and
values are distinct.

• N o rdic skiers were mentioned,
both the traditional gentle
terrain, light gear nordic skiers
who may occasionally venture
into avalanche terrain, and ones
who move into steeper terrain as
their interest and abilities change.

• F i n a l l y, we identified a stro n g
need for pro f e s s i o n a l
development and continuing
education, like our A A A
seminars.

We turned our attention to better
ways to reach our target audiences,
and how we might better “market”
our courses. This discussion came
up with a number of ideas:
• We need to recognize that many

g roups are turned off by the
notion of going to school.
C l a s s room memories may
include humiliation and feeling
stupid. Many among our key
target groups are likely to have
had bad school experiences. We
need to use methods other than
traditional courses, and create a
positive environment when we
do use the classroom format.

• Recruit the stars to spread the
message, especially to youth.
Have them go with you, or give
them the resources they need to
go on their own, or use
multimedia to bring them to the
audience.

• Assimilate fresh approaches and
faces. Again, this especially helps
reach younger audiences. Train a
young apprentice, and take
advantage of their ease of
communication to build your
own skills and credibility.

• Be positive, especially with
youth. Scare stories are a turnoff.
Emphasize that avalanche
knowledge is a way to find better
snow and have more fun, and
that managing risk is part of
having fun.

• Use the web, DVDs, and
electronic media. Young people
especially are totally at home in
the digital world. You need to be
able to go there to reach them.
Ride first! Start your course out
with some turns. Play. Make your
courses fun. Fun is the big
motivator.

• Relate to the activity or group by
becoming part of it. If you want
to reach the kids, spend some
time with them in the terrain
park. Learn to snowboard. Spend
enough time on a snowmobile to
become a skilled rider.

• Learn to teach with all the tools;
learn to communicate from the
viewpoint of every user group.
At the same time, if you really
don’t like an activity, it is better to
let someone else teach that user

group and stick to the activities
you have genuine enthusiasm for.
Build community re l a t i o n s h i p s .
Connections with individuals,
schools, community
o rganizations, businesses, and
ski areas, and government all
help you be more effective and
credible. Respond to search and
rescue calls even if you aren’t
paid to do it. Help out with
community events like ski sales
and safety fairs.

• Think of your teaching as
entertainment. Animate the
message, use games and humor
to capture attention and get your
points across.

• Take informal opportunities to
answer questions and give
information. Attend the trailhead
barbecue, the snowmachine
races, the extreme competitions,
the ski swap, or the alpine
touring race. Have a logo on your
jacket or sled’s windshield that
identifies you. Always be open
for questions and discussion
whenever you encounter people
in the field.

• Snow science can be a curriculum
element in the schools. There was
some discussion of how to reach
curriculum committees and how
to fund curriculum development,
but no consensus; in some areas it
requires a major campaign to fit
another unit into the curriculum,
in others it’s just a matter of
talking to the science teacher.
Mountain and rural schools are
more likely to teach snow science
to all their students, it is more
d i fficult to reach students in
urban schools, where the need
may be seen as peripheral but
w h e re many backcountry
travelers come from.

Then we looked at whether our
courses are making people safer; are
people retaining what we teach and
applying it in the field? What parts
of our courses help our students
make better decisions? Are our
students smarter about risk? And
are they still our there having fun?
In other words, are we actually
doing as good a job as we think?
• The first comment was that our

students are definitely NOT
digging pits. Whether they are
being lazy or acknowledging the
reality of spatial variability and
practicing smart risk re d u c t i o n
through other means is not clear.

• We can emphasize probing and
quick pits as tools for faster
evaluation.

• Ask people what they want to
know early in the course, and be
s u re to cover those re q u e s t s .
Adjust your approach to suit the
group’s needs.

• Keep it simple, especially for
kids, but also for adults.
Emphasize key points instead of
overwhelming students with
everything you know.

• We need to make snow study the
cool thing to do.

• Relate avalanche stru c t u re to
good ski and riding conditions;
always emphasize fun.

• The three necessary ingredients

to make classes happen are the
need for the education, a venue
for classes, and teachers to do the
classes.

• We need to teach people the habit
of trip preparation using
p replanned options and
alternatives.

• We need to learn how to teach the
concepts and actions that value
living.

• Ski patrols need to be especially
conscious of their role as the first
contact with snow professionals
that many young people have. If
they are respectful and encourage
the kids, they can serve as
positive role models and
information sources. Beware
your internal stereotypes and
actively work to counter them.
Take interested folks on
avalanche control if liability
concerns can be addressed.

• Rescue dogs can present another
first taste of avalanche
knowledge to people. Use the
avalanche dogs and handlers for
outreach.

• More ski areas should use beacon
gates as an out of bounds
p recaution and to pro m o t e
avalanche awareness.

We moved to considering the
mix of courses should we be
o ffering, including whether our
traditional course mix is effective,
our curriculum needs improvement,
our courses are long enough, and
whether there is enough field and
hands-on time. What diff e r e n t

approaches might work, what is
already out there that we could learn
from, and how do we best improve
our education efforts? 
• The lead comment was that we

should completely rethink our
a p p roach. Our audience has
changed, and we cannot keep
repeating a now-obsolete
formula.

• We agreed that we need a broad
mix of courses. In-depth courses
should look at snow, not just as it
pertains to avalanches, but as a
b roader topic. Include winter
e c o l o g y, snow hydro l o g y, and
other aspects of snow science. 

• We need to instill enthusiasm.
People can see snow study as a
lifetime of learning, with the
introductory course as just the
first step.

• An advanced workshop during
periods of high avalanche
danger, so people see unstable
conditions firsthand, would be
great. In some areas, courses have
field trips to two field areas with
different snow climates. There is
no substitute for learning at gut
level.

• A once-weekly evening informal
lecture and discussion series has
worked well in some
communities.

• Videos can be a great tool, and
educational videos can be
included with the snow action
videos, especially in DVD form.
Creativity can be used to boost
attendance. Prize drawings,
cooperative pro m o t i o n s ,
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trailhead flyers, and talk shows
have all been used.

• Many Level II students are not
really ready and hold the others
back. We might consider
something between Level 1 and
Level 2 courses, perhaps a one
evening one day refresher, one or
two day field observation or risk
management seminar, or a
touring day with avalanche
emphasis. Another approach is to
require field notes from at least10
days to qualify for a Level II.

• Knowledge ≠ behavior. In other
w o rds, our goal is behavioral
change, not just knowledge
transmission.

• It is difficult for avalanche
i n s t ructors to assess our
outcomes. As our students
spread out into the hills, we lack
accountability and feedback for
how well we have taught. One
idea is to conduct a survey to
evaluate short and long-term
retention, and especially to assess
behavioral changes.

There was widespread support
for short courses, which we clarified
as being typically one evening and
one day. Our consensus felt that this
sort of course better fit our new
audiences than the traditional Level
I.

Some of the data Ian
McCammon presented earlier in the
day suggested that short course
graduates are more susceptible to
some of the heuristic decision-
making traps. Then we posed the
question of how to make short
courses more effective.
• We agreed that short courses

should have an introduction that
covers key concepts and clearly
identifies the problem. The
course should cover rescue, then
focus primarily on risk
management through terrain
analysis, minimizing
consequences, proper travel
procedures, and developing the
habit of choosing lower risk
alternatives. Stability evaluation
and snow study, other than the
recognizing most basic signs of
instability, should not be part of a
short course.

• Teaching tactics comments
included that we need to
determine where our students are
at before we can move them
where they want and need to go.
At a minimum, intro d u c t i o n s
should include a summary of
b a c k g round, avalanche
experience, and “why are you
here?” 

• A couple of brief case histories
can be a great introduction since
people love and relate well to
stories, but take care to avoid
scare tactics. 

• Scenarios and games are good
ways to teach a variety of topics.
Be inventive. Movement and
hands-on, participatory learning
are good.

• We need to find ways to teach
a p p ropriate pro b a b i l i s t i c
methods of risk re d u c t i o n .
Learning for beginners needs to
follow a more rule based
approach. For advanced learners,

a more traditional knowledge-
based approach is appropriate. 

• We need to teach lower- r i s k
travel procedures as daily rituals.
Avoid overload. Keep it simple;
emphasize repetition and
practice of the basic principles.
Resist the temptation to tell war
stories about unusual or odd
phenomena that just confuse
beginners and introduce more
uncertainty than they can handle.
Use short courses as a teaser to
encourage people to take in-
depth courses.

• Short courses should be
inexpensive. Sponsors can help
keep cost down. At the same
time, beware pricing courses so
low that participants do not value
them or take them seriously.

• Ta rget courses to the at-risk
g roups, by activity, age, and
location.

We closed with a comment on the
four levels of learning:
• Bliss – you don’t know what you

don’t know.

• Te r ror - You know you don’t
know.

• Overconfidence - You know you
know.

• Expertise - You don’t know that
you know.

And we added a fifth:

• Wisdom - The more you learn the
less you know.

The larger questions to consider for
the future include: How do we make
it happen? What steps will lead us to
improvement? What next? We hope
to provoke discussion; we invite
contributions and debate. 

Send your ideas to Bill Glude:
snownerd@mac.com

Bill Glude compiled this summary of
e v e r y o n e ’s comments. If he got your
comments wrong, he apologizes and
challenges you to write them up more
clearly in an article for The Avalanche
Review.
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Bill Glude demonstrating the avalanche board.  Photo by Bruce Tremper.

Above, Nancy Pfieffer demonstrates the balancing act education tool.  Photo by
Bruce Tremper.
Below,  Participants at the AAA Avalanche Education Seminar try out the
avalanche spoons game.  Photo by Kirk Backman.
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Teton Gravity
Research Introductory
Avalanche Safety
Efforts
By Jim Conway

or over a decade now, the
E x t re m e / F reeride scene has
been the main focus of ski and

s n o w b o a rd filmmakers and maga-
zines.  This exposure has created a
new backcountry user group that is
perhaps different culturally than tra-
ditional backcountry users.  Te t o n

Gravity Research, one of the most
popular and influential film compa-
nies popularizing this movement,
recognizes its responsibility to not
only promote the sport, but also to
promote safe and responsible back-
country use.  Thanks to the support of
snow safety gear manufacture r
Backcountry Access, TGR has devel-
oped an introductory backcountry
skills video that is aimed specifically
at this new user group. 

At about 15 minutes, the video
covers re q u i red equipment, basic
avalanche beacon skills, route find-
ing, and snow pits.  TGR hopes to
speak to the young freeride crowd in
a language they can relate to, and
with personalities that have credibili-
ty in their culture, by making use of
current and former professional ski
and snowboard athletes.  The main

athletes in the video are Jeremy Nobis
(skier) and Victoria Jealouse (snow-
boarder), with TGR lead guide Jim
Conway hosting.  TGR re c o g n i z e s
that no one can travel safely in the
backcountry simply by watching a
video, so the video also encourages
viewers to take an avalanche course
and to begin the life long learning
p rocess of becoming a re s p o n s i b l e
backcountry user.  This video is a
non-profit enterprise by TGR and the
first of a series of educational projects
that will become progressively more
detailed.

In a similar effort, TGR is running
an interactive online educational pro-
ject, the “Online Avalanche Class.”
This project is under development
and is being produced by Jim
Conway.  The first three lessons are at
w w w. t e t o n g r a v i t y.com under
Conway’s Corner.  With the support
of the ski industry, TGR hopes to
expand these to 25 lessons ranging
from basic to advanced subjects.

The Backcountry video will be an
added feature on all DVD sales of
TGR’s newest film High Life.
Interested educators may also obtain
a copy by contacting Dirk Collins at
TGR (307-734-892 or dirk@tetongrav-
ity.com).  To give feedback on content
or other technical issues, contact Jim
Conway (801-278-5534 or
sarge@aros.net).

Pro snowboarder Jeremy Jones digging a snow pit in a scene from the
TGR introductory avalanche education video. Jim Conway photo. 

Arc’ Teryx ISSW 2004
September l9-24
Jackson Hole, Wy o m i n g ,
Walk Festival Hall.

Mark the dates and reserve your
space now.

Tuition is: 
$l90 until March, 2004
$2l5 until Aug 3l, 2004 
$235 after Aug 3l, 2004

Registration and Information
available at www.issw.net.
Field session on Teton Pass and
Jackson Hole Mountain Resort is
planned for Wednesday,
September 22.

Criteria for submission of presen-
tations and posters will be posted
on the web site.

ISSW Video Library
Now Available
A valuable teaching tool 
and memory aid

The ISSW Video Library is a box
set of 8 tapes in VHS format. 
Cost is $89.99 (US).

For more information and the
order form: please go to 
www.isswvideos.com

e-mail: info@isswvideos.com; 

phone: 
Kellie Erwin 250-344-5707 
Ryan Gallagher 250-344-4666.
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Avalanche Jam II
Raises Over $10,000 
for CAIC

he second annual Av a l a n c h e
Jam, organized by
Backcountry Access, raised just

over $10,000 this September for the
Colorado Avalanche Information
Center.

The event took place outside
the American Mountaineering
Center, in downtown Golden, CO. It
featured music by Boulder funk sen-
sation The Motet, plus copious
amounts of Fat Tire Amber Ale and
barbecued wild Alaskan salmon.
Ticket sales increased by 4 percent
over the 2002 event, with a total of
just under 500 total attendees.  Silent
auction revenues were up 11 percent,
to $9,365.  With expenses totaling
$15,292, the event netted $10,018. This
marked an increase of three percent
over the inaugural 2002 Avalanche
Jam.

“It was an outstanding
event,” said CAIC Director Knox
Williams.  “The planning was great
and everything went smoothly.  We’re
very pleased.”

“ We don’t often get the
opportunity to meet face-to-face with
our users; that to me was the most
interesting part,” said CAIC forecast-
er Scott Toepfer.  “It’s very gratifying
to see this kind of support from back-
country users.” 

While revenues were up, so
w e re expenses, according to BCA
P resident Bruce McGowan, who
pointed out that last year’s inaugural

event was “guerrilla” in nature and
therefore less expensive to produce.
He said next year BCA will focus on
increasing participation to offset the
relatively fixed expenses of the
venue, event insurance, and enter-
tainment. 

Sponsors of the Av a l a n c h e
Jam included organizer Backcountry
Access, beer supplier New Belgium
B re w e r y, Kodiak Island Salmon,
Rescue Te c h n o l o g y, Atomic, Lowa,
Rossignol, MSR, Lowe Alpine, The
North Face, Patagonia, Mountain
Hardwear, Burton, Black Diamond,
Cloudveil, Couloir magazine, La
Sportiva and Suunto.

In addition to The Motet, the
life of the party centered around the
CAIC booth, where participants
flocked to watch a compelling video
created by Toepfer.  The video fea-
t u red numerous skiers and snow-
boarders getting caught in avalanch-
es.  At one point, the band com-
plained that the crowd was being dis-
tracted from the music by the action-
packed video production.

“ We ’ re looking forward to
doing this event next year at the same
exact time,” said BCA Sales Manager
Steve Christie, who took charge of
gathering sponsors. He said the first
Friday after Labor Day weekend
works well because most people
choose to stay in town after the long
weekend and it’s the perfect time to
“kick off” the ski season.

—Nick Logan
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Forest Service
National Avalanche
Center Holds Annual
Avalanche Center
Meeting
By
Doug Abromeit and
Karl Birkeland

n October, the Forest Service
National Avalanche Center
(NAC) held its annual meeting for

regional avalanche center personnel
at Snowbird, Utah.  The annual
meetings enable the centers to share
information and ideas, and they help
a s s u re operational consistency.
Participants discuss and share
relevant management and technical
information.  This year the NAC held
the meeting in conjunction with —
and two days prior to — the
American Avalanche A s s o c i a t i o n
meeting.  About 50 people attended
from as far away as Alaska and New
H a m p s h i re.  The participants
included representatives from nearly
every U.S. avalanche center and
several other people involved in
avalanche research and education.

The first day was devoted to both
the soul and the nuts and bolts of
running an avalanche center.  Tom
Kimbrough started things off with a
wonderful slide pre s e n t a t i o n
reflecting on his many years as a ski
p a t ro l l e r, avalanche forecaster and
climbing ranger.  Tom’s presentation
included Buddhist poems and
tributes to fallen comrades.

Ethan Greene and Karl discussed
possible guidelines for weather,

snow-pack and avalanche
observations.  Ethan and Karl worked
long and hard on the Guidelines, and
they were well received by the group.

Bruce Tremper, Director of the
Utah Avalanche Center, told about his
trip to Norway to attend an
avalanche seminar and participate on
a panel that included avalanche
experts from around the world.
B ruce re p resented the US and
described how US avalanche centers
gather data and disseminate
information.

Colleen Graham, President of the
Friends of the Utah Avalanche Center
and a Black Diamond Equipment
employee, discussed the very
successful Black Diamond/UAC
Fund Raiser.  Her discussion included
suggestions for other Friends groups.

F o rest Service Regional
Recreation Director Liz Close gave
her perspective on the avalanche
centers, including funding.  Liz has
been very supportive of the NAC and
the avalanche centers, and it was
great to have her at the meeting.

Doug Chabot described the
exciting SnowPilot project that will
give Palm Pilots to avalanche center
personnel to record snow pit data
with this winter.  Doug also discussed
the excellent Snowmobile Brochure
developed by Jill Fredston and Doug
Fesler for the state of Alaska.   Jill and
Doug and Alaska have allowed other
states and organizations to use the
brochure.

Doug and Karl gave a run down
on NAC activities the past year
including the military artillery
p rogram, a Homeland Security
explosives audit and several research
projects.

Liam Fitzgerald, long time snow
safety director at Snowbird and
current Lead Forecaster for the Utah
Department of Transportation in
Little Cottonwood Canyon, offered
some more soul.   Liam dramatically
described the often difficult and gut-
w renching job of fore c a s t i n g
avalanches when lives and property
are at stake.

Chris Joosen, Director of the
White Mountain Avalanche Center in
New Hampshire, described two
s e a rch and rescue missions in
Tuckerman’s Ravine this past winter.
Chris put an end to stereotype that
avalanches do not occur in the
northeast.

We finished the first day with
wrap-ups from each avalanche
center, and then we retreated to the
Tram Bar to continue discussions.

The second day of the meeting
was devoted to technology transfer,
with plenty of time allowed for
discussion throughout the day.  Karl
Birkeland discussed the status of
several projects, including utilizing
the Swiss models SNOWPACK and
NXD2000, and the new
SnowMicroPen.  In addition, he and
Montana State University (MSU)
graduate student Spencer Logan
presented an outline of an ongoing
two-year spatial variability pro j e c t
that the National Science Foundation
recently funded.  Kelly Elder, a
researcher with the Forest Service’s
Rocky Mountain Research Station,
gave an excellent presentation on
snowpack energy balance and its
implications for avalanche
f o recasting.  NOLS instructor Ian
McCammon presented an
illuminating talk about fracture

mechanics.  As those who have heard
Ian talk will attest, he has a gift for
translating rigorous scientific
investigations into usable
information for practitioners.  

In the afternoon, the first topic
was wet snow avalanches; MSU
graduate student Simon Tr a u t m a n
discussed his wet snow research near
Bridger Bowl and Glacier National
Park avalanche forecasters Blase
R e a rdon and Chris Lundy share d
their eye opening experience dealing
with a large wet slab cycle during the
opening of the Going-to-the-Sun
highway last spring.  Doug Abromeit
then made a presentation on
avalanche forecasting in Switzerland.
Pascal Hägeli, a PhD candidate from
the University of British Columbia,
closed out the day with a summary of
Werner Münter’s risk reduction and 3
by 3 methods.  Pascal’s presentation
led to a lively debate about the
methods and their use in the United
States, which in turn led folks to head
to the bar for beers and even more
spirited debate. 

The core missions of the NAC
include helping to coordinate the
avalanche centers, maintaining
consistency between them, and
p roviding technical information to
avalanche center personnel.  Our
annual meetings are helping us to
meet that mission, while allowing
friends and snow geeks to gather and
share stories and drink a few beers!
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aptioning Photos
One of the coolest things
about digital photos is that

most image editing pro g r a m s
allow you to edit the “meta data”
for each image.  In other words,
you can add photo captions, key-
words, a copyright, and so on.
This information is embedded
into the file and no matter if you
edit the photo, save it as a differ-
ent file type or e-mail it to some-
one, it’s always there.  If someone
wants to see the captions or key-
words of the photo, they simply
view it in a program that allows
them to look at the file info.  For
instance, Microsoft Explore shows
some of that information when
you hold the mouse over the file.
If you right-click on the photo,
then click P ro p e r t i e s and then
Summary, you will find even more
information displayed.  Try to get
in the habit of captioning your
photos within a couple days after
you take them.  Otherwise, you
tend to forget the details and
dates.  In Photoshop 7 or
Photoshop Elements, you can cap-
tion photos or view the captions
entered by others by going to File
> File Info.

Editing Images on the Computer
One big advantage of digital

photography is that you can edit
the image to your heart’s delight
after you take the photo.  Modern
digital cameras are re m a r k a b l e
machines because they automati-
cally correct most of the problems
common with untrained photog-
raphers and the limitations of
film, so digital images usually
don’t require much editing.  But
digital photos of snow suffer from
many of the same problems as
photos using film, so you will
need at least a simple image edit-
ing program to make them look
their best.

I have played a little with the
consumer-oriented image editing
programs, and from my limited
experience, Adobe Photoshop
Elements seems like the best of the
bunch.  It only costs around $70,
and it will do everything most of
us need.  You can download a one
month trial version at
w w w.adobe.com.   I have also
read good reviews of Ulead Photo
Impact and Jasc Paintshop Pro.  If
you have some serious time and
money on your hands, you should
spring for the full $600 version of
Adobe Photoshop 7.  But realize
that Photoshop 7 is an extremely
sophisticated program, and it
takes a year or two of diligent
work to learn it.  Also, once you
get started, it’s extremely addic-
tive, so you will also need an
understanding spouse.  Sadly, I’m
one of those addicted to
Photoshop 7, but then I’m an

incorrigible geek.  In this article, I
will assume that you are using the
cheaper and more user- f r i e n d l y
Adobe Photoshop Elements, and I
will list the commands for some of
the essential operations.  

Make the Snow White instead of
Grey

Just like with film cameras, if
you fill most of the frame with
snow, it will almost turn the snow
dirty grey.  Why?  Because the
camera doesn’t know that you are
taking a photo of snow.  It
assumes that every scene should
be a neutral tone—like the inside
of your living room, for
instance—and it turns the nice,
white snow into a neutral tone.
Try this experiment: with a cam-
era set on automatic mode, shoot
a black wall, then shoot a white
wall.  Surprise…they will both
look identical—dirty grey.  With
film, the time-tested solution is to
overexpose snow by about a stop
and a half.  And correspondingly,
to make dark things look dark,
you have to underexpose by
about a stop and a half.  With dig-
ital cameras, you will have to do
one of two things:

• If you are shooting in auto-
matic mode, try to include a
significant amount of other
objects besides snow in your
photo, such as blue sky, trees,
people or rocks.  

• Shoot in manual mode and
overexpose the snow by about
1.5 stops. (Advanced tech-
nique: an incident light meter
works great for snow photos)  

In the editing process, one
quick way to correct a dirty gray
photo is to choose Enhance > Auto
Color Correction in Photoshop
Elements.  Don’t be tempted to
use Auto Contrast or Auto Levels
because they are both pretty lame
utilities.  Auto Color Correction is

much more powerful and usually
gives you better results.  For aver-
age photos it works fairly well,
but for most snow photos it leaves
something to be desired, where-
upon you must use the following
method:  

Go to Enhance > A d j u s t
Brightness/Contrast > Levels (or
use the shortcut Ctrl L).  Now, you
can run the little sliders at the bot-
tom of the histogram.  The middle
slider adjusts the overall bright-
ness, the right hand slider adjusts
the highlights and the left slider
adjusts the dark areas.  Try sliding
the right and left sliders so that
they are at the edge of where there
is some data in the histogram
(where the graph jumps up from
the base line).  This tends to make
the whites, white and the blacks,
black.  If you want to see a little
more detail in the shadows and
the highlights, run the right and
left sliders a little farther away
from the edge of the histogram.
Then, finally, adjust the middle
slider to make the image look
right.  Experiment.

How to Sharpen Photos
Almost all photo editing pro-
grams have a sharpening feature
and most of them don’t work very
well.  It just makes the photo look
grainy and pixilated.  In
Photoshop Elements, go to Filter >
Sharpen > Unsharp Mask.  In the
dialog box change the amount to
85, the radius to 1 and the thresh-
old to 4.  This is a good, all-pur-
pose sharpening that doesn’t
overdo it too much.  If you need
more sharpening, do it twice.  

Advance technique:  If you
have Photoshop 7, here is a much
better way to sharpen the photo,
which only sharpens the black
and white part of the image but
leaves the color alone and doesn’t
leave the image as pixilated or
grainy.  Go to Image > Mode >
Lab Color.  Then in the Channels

dialog box on the right (if it’s not
open, click on View > Channels)
click on Lightness.  This changes
the photo to black and white.
Now, do the sharpening on this
black and white version of the
photo.  Finally go back to Image >
Mode > and click on RGB Color to
turn it back into color again.  

How to Turn a Photo into Black
and White.

If you are sending a photo to
The Avalanche Review , you can
make the file size smaller simply
by leaving out the color.  To make
a black and white image, you can
simply go to Image > Mode and
click on Grayscale. 

Advanced technique:  If you
have Photoshop 7, go to Image >
Mode and choose Lab Color.
Then in the Layers box on the
right of your screen, click the
Channels tab, then click on
Lightness.  Now, go back to the
Image > Mode and this time click
on Grayscale.  It will ask you
whether you want to discard the
color channels.  Answer yes.
Now, you can adjust the photo
using the Levels command (Ctrl
L) until it looks right.

How to Prepare Photos for E-
Mailing or Posting to the Web

To e-mail photos or post them
on the web, you need to turn them
into a small file.  Virtually every
image-editing program allows
you to save your image as a small-
er file.  For posting on the web, try
to keep them under 100 kilobytes
and for e-mailing, most e-mail
programs will balk at attachments
larger than one megabyte, so the
smaller the image, the more
images you can attach.  Always
save them as either a JPEG or as a
GIF.

In Photoshop Elements, go to
File > Save for Web.  For width
and height, you can adjust the size
to about 600 x 400 pixels, which
will fill up about half of a typical
computer screen or you could go
for 800 x 400, which would fill up
most of the screen.  Notice that the
file size listed at the bottom of the
box will reflect your choices.  You
will also notice two diff e re n t
images, the original on the left
and the compressed image on the
right.  Adjust the number in the
Quality box until the image still
looks good but it’s a small enough
file size for your needs.  On the
lower left of each photo you will
find the image size and the time it
would take to send the photo on a
28 K dial-up connection.  Since
most people use a minimum of a
56 K modem these days, you can
cut these times in half.  Then click
OK and save the image under
another file name.  I usually put
WEB somewhere in the name, so I

Surviving Digital Photography, Part 2:  
Managing and Editing Images
By Bruce Trempe

Editor’s Note: This article is the second installment in a two part series.  In the first
installment, which appeared in the October, 2003 issue of The Avalanche Review,
Bruce described the advantages of digital photography, using a digital camera for
taking pictures of snow, and file types.

Figure 1:  The Levels dialog box in Adobe Photoshop Elements
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know it has been shrunk down for
the web or e-mailing.

Automating the File
Compression Process

Now that you know how to
c o m p ress files manually,
Photoshop Elements, as well as
several other programs, have a
g reat utility for automatically
resizing and compressing a num-
ber of photos at the same time.
You can imagine how excited I
was when I discovered this utility.
It’s easy.  Simply put all your pho-
tos you want to compress into a
separate directory.  Then, go to

File > Create Web Photo Gallery.
This utility is designed to create a
web page so you can publish all
your photos on the Internet.

In the Folders section, click
Browse and specify the directory
where you stored the photos you
want to compress.  Then in the
Destination box, choose another
d i rectory where they will be
stored after they are resized and
compressed.  In the Options sec-
tion, click on Large Images in the
d rop-down box and you can
choose what size in pixels you
want the compressed photos to be
(the resolution is automatically
72) and also choose the amount of
compression you want.  Then let-
er-rip-tater-chip.  Click OK and
your computer chugs away com-
pressing all your photos.  When
it’s done, it will open up a web
browser to show you how your
web page will look. When you are
finished being impressed by your
prowess (with a little help from
Photoshop), then close the brows-
er window.  Go to the directory
where the program stored your
web page.  You will find all your
re-sized and compressed images
in a sub-folder called Images.
Now, you can e-mail these photos
or put them into your own custom
web page.  Easy.

If you don’t own Photoshop
Elements, there are a number of
cheap programs designed to turn
your photos into your own web
gallery. You can download them
from the Internet.  Go to Google
and search for Create Web Gallery
Software.

Get Rid of the Dreaded Blue

Snow
For whatever reason, this is prob-
ably the hardest task in any image
editing program.  For years, this
problem drove me crazy.  Here are
four tricks that work fairly well.
No one trick works in all cases, so
you will have to have a few in
your quiver.

First, I’m assuming that you
a l ready tried the Auto Colors
command and it didn’t work very
well.  Sometimes it works great
and sometimes it makes the photo
look horrible.  If this is the case,
then try the first slick trick:  

Slick Trick Number 1: Photoshop
Elements has a slick utility in

Enhance > Adjust Color > Color
Cast.  Simply click the eyedropper
tool on a grey or white part of the
snow.  This adjusts the colors in
the rest of the photo as well so it
sometimes makes the non-snow
areas look goofy.  Keep clicking on
other grey-looking or white parts
of the photo until you can get
something that looks good.  A
dirty-gray patch of snow usually
works well. 

In Photoshop 7 you can go to
Image > Curves and choose the
middle (mid tones) eyedro p p e r
and it does about the same thing.  

Slick Trick Number 2: I n
Photoshop Elements, go to
Enhance > Adjust Color > Color
Variations.  Click on Highlights
button and you can adjust the
three colors separately with a slick
little before and after preview to
see how the adjustments would
look.  

Advanced Technique: If you have
Photoshop 7, go to Image >
Adjustments > Selective Color. At
the top of the box, click on the
d rop down menu and choose
“white”.  This only adjusts the
white colors in your photo.  Now
decrease the cyan slider and boost
the yellow slider until it looks
about right.  You can also add or
subtract black to make it look
exactly the way you want.

If You Really Want to Get Fancy:
This takes the longest time but it
works nearly all the time.  If you
have Photoshop 7, here is a great

trick I learned in a Photoshop
seminar.  First, click and hold on
the eyedropper tool and choose
“Color Sampler”.  Then find the
brightest white part of the snow in
your photo and click there to
anchor the sample point.  Either
right-click the sample point or go
to the menu above and change the
sample point size from 1 x 1 pixels
to 3 x 3 or 5 x 5 to sample a larger
area.  Then, make sure the Info
menu is open on the right.  If not,
click on Window and click Info.
In the Info window, you will
notice that the first point you
clicked will show up as #1 in the
window and will show you the
values for R, G and B (red, green
and blue).  The idea is to make all
these values the same, which will
create a color-neutral white.

Go to Image > Adjustments >
Levels (or use the shortcut Ctrl L).
In the top of the Channel box, you
can click the down arrow and
choose to edit either RGB, red,
green or blue.  Look at the Info
box and see which color has the
highest number and you need to
adjust the other colors to bring
them up to that number.  Since we
are trying to take blue out of the
snow, the blue will be the highest
number, so back in the levels box,
click on red in the drop down
menu to get the histogram of red
colors in your image.  Now, run
the right hand slider at the bottom
of the histogram to the left until
you can see the values for the red
color in the Info box equal the val-
ues for blue.  Next, do the same
thing for green.  Now, your snow
should look perfectly white.
Magic.  Finally, adjust the middle
slider to make the snow look the
right brightness. Click OK to save

your adjustment.  Whew. It’s long
and involved but it works great.

Summary
OK, I said that this was a

quick, basic primer on digital pho-
tography and, as you can see, it
quickly turned into a tome.
Digital photography can be just as
complicated as it is powerful.  As
the technology progresses, many
of the more labor-intensive and
complex tasks will become more
automated.  If you’re a beginning
user, start with the small and sim-
ple things.  Organize your photos
on the computer.  Give them cap-
tions and keywords.  E-mail them
to friends.  Intermediate users will
learn to post their photos on the
web and adjust their size and res-
olution to look good on the web,
yet download quickly. Advanced
users will buy the full version of
Photoshop 7 and begin the long
process of learning how to tweak
their photos to look their best.  

As you can probably tell, I
love the exciting new medium of
digital photography.  I feel like a
kid again—learning a whole new
art form.  I just wish I had all these
tools available 30 years ago.  

Bruce Tremper is the Director of the
F o rest Service Utah Av a l a n c h e
Center and made a living as a photog -
rapher before he caught the avalanche
bug 25 years ago.  He spends his sum -
mers as a photographer and writer.
Bruce recently won the prestigious
Nature’s Best Magazine photography
competition for the People in Nature
category.  His image is on display in
the Smithsonian Museum of Natural
History in Washington D.C..

Figure 2: The slick little color correction eyedropper tool.
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his spring in the Chugach
Mountains near Gird w o o d ,
Alaska was from most years in

that the snow pack seemed shallower
than usual. The snow pack was affect-
ed by wet snow, and there was a lot of
rain during January and February. I
logged a lot of ski days in February,
including seven consecutive days at
Summit, Video Land near Johnson’s
trailhead, the south facing aspect of
Magnum, and Tin Can. All of the ski-
ing had been great. There were a cou-
ple of layers of snow that were sus-
pect, but with time, the areas we were
willing to explore seemed stable.

I left for a weeklong ice climbing
trip to Valdez at the end of February,
and returned to Girdwood the night
of the 10th. It was very windy during
my trip to Valdez. Driving through
Anchorage the way back the day
before was impressive. There was so
much dust in the air, it looked like
pollution. My group informed me
that there had been similar wind in
the Pass (Turnagain Pass) during that
prior week. They had been skiing in
the Pass daily the week leading to
March 11th. All snow had seemed sta-
ble, even with the prior wind loading. 

Our group included Abe Gioffre,
age 23; Ryan Morril, age 27; Jake
Young, age 23; Aaron Long, 24; and
me; Joni Earp, age 27, all of

Girdwood. Between the five of us, we
probably have about 50 years of ski-
ing experience- maybe more. As for
backcountry experience, three mem-
bers of the group, Abe, Jake, and I
g rew up in Alaskan mountains.
Individually, we began scaling peaks
to ski them starting around the age of
fifteen. Skiing had brought us to the
Chugach Mountains, and I had spent
a lot of my early years touring in
Hatcher’s Pass, north of Palmer. I
have skied many areas in A l a s k a
including peaks off the Matanuska
Glacier, a week around the Castner
Glacier near Paxon Lake, and a week
long ski trip on the Ruth Glacier in
the Alaska Range. I have skied the
backcountry mountains of Colorado
w h e re I attended Western State
College in Colorado for three years. I
had ski toured in France, when I lived
in Tignes / Val d’Isere for a year at
the age of 22. I took my first
avalanche course while attending
WSC my freshman year at the age of
19. I felt comfortable in the mountains
and have always skied with experi-
enced skiers. I have even skied the
backcountry solo on several occa-
sions.

We got to the parking lot, and
began moving up the snow machine
trails to the base of the first mountain
that we would climb that day. I

remember feeling great, and the snow
had a firm pack on the lower skirts of
the mountain due to the snow
machine tracks. I can recall getting to
the top of the mountain and being in
awe of our ski objective. What an
impressive peak. I had not viewed
the peak before as it is obscured by a
smaller mountain near the Seward
highway and is not seen from the
road. The northeast facing aspect of
Big Chief is dramatic. The face is
steep, including several rock bands.
Due to this, it is rarely skied. The
south flank of the mountain, our
ascent route, meets the creek. From
this vantage point, I could not make a
definite plan for descent. It looked so
fun; I couldn’t wait to get over there.

Our group took turns skiing 1,500
vertical feet down to Seattle Creek.
We stopped and ate some food. It was
then that I noticed we were really
going to have a long day since we
would have to regain the elevation
back out of the valley after having
skied Big Chief. I recall saying to
myself, “if something happens out
here, we’re far from the car.” I was
skinning a lot slower than usual, and
I remember the face we were skin-
ning was quite steep. I had a hard
time edging the snow as there was
sun and wind crust on the surface,
making the top layer firm and almost
icy. The temperatures at the bottom of
the creek bed were freezing, and I
was still cold though gaining speed
and altitude quite rapidly. I believe
my ascent of the peak took around an
hour and fifteen minutes.

When I reached the summit, the
guys were there already. The adiabat-
ic lapse rate coupled with the wind at
the top made for a chilly experience;
t e m p e r a t u re seemed around ten
degrees Fahrenheit. I recall putting
my plastic water bottle in my ski
pants to melt the ice that was formed
in my water. There were gusts of
winds up to about fifteen knots, with
an occasional twenty knot blast. It
made conversation hard, and we
were all anxious to get on the slope
and away from the wind onto that
beautiful face. Conversation in our
group had been lacking all day. I was
surprised earlier in the day when
members of the group had begun the
ski descent down into Seattle Creek
without saying anything about where
they were going. I was also surprised
that we did not discuss what lines we
wanted to ski on Big Chief while we
had a view of the face. I was standing
on a mountain that was so steep it
was impossible to see the line from
the top. I was freezing and wonder-
ing, “when is it my turn?”

Jake skied down first as he was
filming for his movie, and wanted to
get his camera set up. He skied down
the far looker’s right of the face and
released a small slide near the bottom
of his run. We did not have radios;
they would have been useful in warn-
ing us about the smaller slide and
possibly steering us away from the
slope. Aaron then skied down the line

that I would soon be skiing. He made
medium sized turns, and was soon
out of our view from the top. We
waited for a while, and did not see
him ski out into the bowl visible at
the base of the mountain. I was freez-
ing at this point and just wanted to
get off the peak and onto the face and
enjoy my run. I had asked Abe where
he was going to ski. I confided that I
did not know which line I should take
as I didn˙t spend enough time looking
at the face before we reached the
summit. Abe and Ryan were nice and
let me go as I was complaining of
cold. My eyes were watering, and the
tears were freezing to my face. I had
the cold water bottle against my
stomach to thaw the water so that I
could have something to drink on the
way out.

I noticed that Aaron had skied
directly onto the face after executing a
ski cut. At this time; however, he was
still on the slope. Ryan had told me
that Aaron was in a good spot, and
that I was clear to make my run. As I
skied down the powder, I had a huge
smile on my face. I was making big
fast turns, and I recall counting ten
turns. Aerial photos taken after the
slide would prove my math to be cor-
rect. I recall thinking that something
did not feel right. I dismissed the
thoughts as being tentative about my
line as the face got steeper and steep-
er. I wanted to have a fluid run, and
not to have to stop to negotiate my
line. After my tenth turn, I thought
something felt bizarre; I looked over
my left shoulder to see where my
sluff was going, and there was no
sluff being created by my turns. I
thought that was weird, and as I
began to make a larger turn to the left,
the snow gave out. I heard a large
boom, and I tried skiing to the left as
fast as I could so that the avalanche
that I had just created would not take
me down. As I skied to the left, I
could see the snowline break away in
front of me. There was no way that I
would be able to ski out of this one.
My left ski then fell off. I could feel
my right ski was still on as I was
being brought down the face by the
snow surrounding me. I scre a m e d
loudly; Ryan told me later that he will
never forget my scream. I thought I
was not going to be able to walk
away from this one. I recall thinking
to myself that I would have to stay
strong and fight with all of the power
that I had. After the initial snow sur-

An Avalanche Report on Big Chief Mountain 
in the Seattle Creek Drainage of the 
Chugach Mountain Range in Alaska. 
March 11, 2003
By Joni Earp
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rounded me, I could not see a thing,
just white. I couldn’t breathe. The
snow began to get heavy on my head
and it began to get darker and darker.
Just then, I could feel myself falling.
While I was in the air I could breathe
and get a view of my surroundings
for a second. Then it was white again,
I knew that I was going very fast at
this point. I could feel my right ski
torn from my boot at this point. I felt
something hit my right arm, and then
I was airborne again. I could tell that
I was still moving very fast, and then
I could feel myself slow down a little.
For some reason, I knew that I was in
the run out at the bottom of the hill,
and that this is where my struggle
would have to begin if I were to make
it out alive. I remembered the sum-
mer before when Abe and I would
have silly competitions at the
Girdwood pool. We would sit in the
pool and see for how long we could
hold our breath. I think I got my time
up to about two minutes. I did not
know how long I would be able to
stay conscious without air. At that
point I could feel the snow below me
moving faster. I shoved my feet down

into the snow as hard as I could, and
tried my hardest to swim or to put
my arms out in an iron cross position.
For some reason, my strategy was
working. I could feel the weight of
the snow around me getting lighter,
and I began to see actual light. My
mouth, eyes and nose were out of the
snow when the snow stopped mov-
ing. I knew that I would have to get
out of there fast before the snow set
up. I then dug myself out as fast as I
could. I got out of the snow, and
yelled so that my group would know
where I was. I ran about four little cir-
cles until I could tell that I needed to
sit down. My arm was hurt.

Jake skied up to me and is unable
to say anything. I would later learn
that my elbow was dislocated, and
that I had broken my humerus and
shattered my right pinkie. Abe and
Ryan showed up within a minute and
a half after I had dug myself out. I
was ready to get out of there. I then
learned that Aaron had been on the
slope when I released the slide. He
was swept down the mountain for
about forty feet, but managed to keep
his skis on and was able to ski away
from it.  Looking at topographical
maps of the mountain, we discovered
that I had been taken anywhere from
1,500 to 1,800 vertical feet falling off
of two 35 to 40 foot rock bands.

Abe took a coat from his bag, and
we used it as a sling for my painful
right arm. The valley floor near the
creek was very cold, and the water
bottle that I had put in my ski pants

near my stomach was still there. I
noticed a hole in my right arm of my
down coat, and would later realize
that my ski pole had gone through
five layers of clothing to puncture my
right bicep. Someone found one of
my Volkl Explosive’s, which were a
graduation present from a friend who
had been in an avalanche two weeks
prior. The first foot and a half of the
ski was badly bent, and we had to fit
Aaron’s ski to my other boot, as we
could not find my second ski. It was
slow moving back up the other side
of the valley once we crossed the
creek. It was nice to make it into the
sun since I knew that I would have to
buck up and ski out of there as soon
as possible in order to avoid skiing
back in the dark. It took about an
hour and a half to get up the backside
of the hill and then skied down the
snow machine’s side of the hill to the
car and to the hospital. I would later
get surgery on my right pinkie. I still
have the pin in my finger.

My life was spared. I am alive,
and I feel it important for others to
learn from my accident. I would like
to emphasize how important it is for

groups to communicate before, dur-
ing, and after skiing in the backcoun-
try. Looking back, I find myself won-
dering why I did not vocalize my
thoughts about discussing our plans
while on top of the mountain. The
signs were there: recent wind load-
ing, the shallow snowpack, a couple
of suspect layers that had until then
not been moving. I heard later that a
friend had released quite a large slab
near the site we were skiing on the
same aspect of the line that I intended
to ski. It would have been good for us
to know this information. We needed
to talk to people that had been out in
that area. Though members of my
group had been skiing every day up
till the 11th, nothing had been mov-
ing. The community of skiers in
Girdwood is pretty close knit, and to
keep the communication lines
between parties open is important. It
would have also been good to check
the Forest Service avalanche web site.
Human error played a large role in
the avalanche that I started. One les-
son that I would want people to learn
from this: communication, education,
and assessment skills need to be used
at all times in the backcountry.

Joni Earp was born in Nome, Alaska and
raised in Eagle River, AK.  She loves
running in, climbing on, skiing down,
and exploring ice and snow covered peaks
around the world.

*Contributions, assistance and
thanks to Carl Skustad, Snow Ranger,
U.S.F.S., Sam Albanese, Meteorologist,
National Weather Service Alaska
Region, N.R.C.S., Jim Kennedy, Snow
Safety, Alyeska Resort, Warren Rowe,
A.M.G.G., oakleycochran.com, Joni
Earp, Jake Young and Paul Laca.  Photos
by Laca/Snow Dynamics.

inter 2003 in the Western
Chugach mountains near
Girdwood, Alaska started

warm and wet. Rain fell throughout
November and December in the
lower elevations with fair snowfalls
above treeline.  Jim Kennedy, Snow
Safety at Alyeska Resort  in
Girdwood reports 47% of average
snowfall for November 2002, 100%
in December 2002 and 61% in
January 2003 from recordings at the
midway elevation of 2200’. Certainly
a warm beginning to an Alaskan
winter.

Early February saw periodic
snowfalls and two large wind
events. Gusts up to 98 miles per hour
and 24 hour precipitation amounts
totaling 9 to 10 inches of liquid water
the first week of February prompted
an extraordinary winter flood
warning for small streams in the
a rea.  On February 6 avalanche
mitigation along the Seward
Highway near Girdwood resulted in
a slide that closed the highway for
several hours, and there was also an
avalanche fatality in Hatchers Pass,
Alaska on February 9. 

February 15 was the first cold
day in weeks.  Surface hoar and
n e a r-surface facets formed at
Turnagain Pass during this short
clearing of two days.  Low pressure
returned and deposited intermittent
amounts of low-density snow over
the now buried surface hoar for the
next eight days.  Total amounts
varied with elevation and location
due to localized winds, and the
storm boards at the snow study plot
in Turnagain Pass totaled 17”. 

On February 23 and February
24, an occluded front with a strong
low near the Aleutians moved into
Southcentral Alaska dropping one to
two feet of snow in the region.  It
also produced locally strong winds
t h rough Western Turnagain A r m
including the Seattle Creek drainage
near Turnagain Pass. Peak gusts
were recorded at 78 miles per hour.

On February 25,  U.S.F.S. Snow
Ranger Carl Skustad, Sean Dewalt
and Craig Patterson of Snow
Dynamics investigated a skier-
triggered slab avalanche on Tincan
Mountain in Turnagain Pass.  The
class 2.0 avalanche was triggere d
after a skier dropped off a ridgeline
and into a wind-loaded convexity
with a 38 degree slope.  He managed
to ski out, and was uninjured.  The
c rown varied from 11 to 29
centimeters, and was 50 meters wide
and 100 meters long.  Mixed hard
and soft debris ran into a deep
terrain trap, and densities were 271
kg/m3 in the deposition area.  The
avalanche failed on intact buried
stellars and surface hoar.  Overlying
this weak layer was a slab of 177
kg/m3 new snow, made up of
decomposing and rounded grains.
The multiple observed natural

avalanches in the area were reported
on the U.S.F.S. avalanche advisory
the next day.

For the next two days a storm
deposited 8 inches of new snow in
Turnagain Pass. The avalanche
advisory on February 28 reported
that snow stability tests had
consistently low scores, and that the
buried surface hoar was intact and
reactive to relatively low stress, and
was waiting for a trigger.

From February 29 to March 7, a
few cloudy days and light to
moderate winds allowed the snow
pack to adjust slightly.   No new
natural avalanches were observed,
although easy shears were still being
noted in the region by Skustad and
Dewalt.  Clear days followed, and
backcountry users returned in
numbers to Turnagain Pass.  

M a rch 8 brought another big
wind event to the area, with
f o recasted winds to 55 miles per
hour, which for the next 48 hours
loaded alpine slopes and starting
zones. On March 9 the avalanche
advisory stated that no new natural
or human triggered avalanches had
been observed or reported, but
warned that additional loads could
exceed the strength of the snow
pack, especially in certain terrain
features without supported slopes.
March 10 and 11 brought clear skies
and continued alpine winds, and
more loading on the same slopes on
Big Chief where 5 Girdwood skiers
w e re venturing the morning of
March 11, 2003.

On March 12, A a ron Long
contacted Snow Dynamics
Avalanche Safety Programs in
Girdwood to report the avalanche
accident the previous day.  He
mentioned the peak, aspect and that
hangfire above the crown existed.
Sean Dewalt chartered a helicopter
to attempt an avalanche
investigation and fracture line
profile.  He brought along Warren
Rowe, a local helicopter skiing guide
intimately familiar with the Seattle
C reek area, and Paul Laca, a
snowboard freerider from Tahoe to
shoot photos.  The goal was to assess
the hazard, enter the bed surface
from a safe vantage, collect data and
shoot arial photos.  When the
helicopter entered the upper Seattle
Creek drainage toward the headwall
of Seattle Creek, it became very
obvious that the hangfire posed a
risk none in the party was willing to
take for data.  After several passes
a round the peak, the helicopter
returned to Girdwood.

Although no hard data was
collected, we hypothesize that the
failure layer was the surface hoar
f rom February 15 and 16 under
windslab formed from snowfall
transported by the 2 large wind
events of February 23- 24 and March
8- 11. 

Sean Dewalt is the owner of Snow
Dynamics Avalanche Safety Programs
in Girdwood, Alaska.  He can be
reached in Alaska at 907.754.7326 or
online at snowdynamics.com.

Avalanche Accident Summary
Big Chief Avalanche, Seattle Creek, 
Turnagain Pass, Alaska
March 11, 2003

By Sean Dewalt
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Three skier-triggered avalanches in 5 minutes on Big Chief Mountain, approximately 15
statute miles from Girdwood, Alaska in the Western Chugach Mountains." Photo by Paul
Laca / www.snowdynamics.com



he Colorado winter of ‘03 had
been difficult.  I was fried and
decided I needed some new

scenery, something far from home, maybe
another winter?  I contacted Henry
Purcell, a friend who I’ve known for a
long time.  He has been the owner and
manager of Ski Portillo since 1961 and
probably knows more about me than he
would admit.  I asked him if I could come
down on a work/study program for the
season to study snow and learn some new
forecasting tricks.  He replied, “This could
be interesting” and that he’d work on it. I
told him, “I’ll scrub dishes and floors, it
doesn’t matter.”  By May a plan evolved.
“How about setting up a data program
for weather/snow/avalanche infor-
mation?”  Henry thought it over and I
was invited to Portillo.  I was stoked!  I
had not spent much time there since 1980,
when I lived in a snow cave, studying the
maritime snowpack for the season.  

I arrived in Chile mid-June to attend

a 60th birthday party for Tim Lane, a
friend of 30 years and avalanchistia for
the Andena Mine.  My other mission was
to spend the season in Portillo, Chile
working with Frank Coff e y, avalanche
forecaster for SkiPortillo.

I have been friends with Frank as
long as I have with Tim.  We guided in
P e ru for many seasons and knocked
around the Rockies and the southwest
deserts together.  He spent 18 seasons at
the Crested Butte ski area, 5 at Chugach
Powder Guides as lead guide and

operations manager and this was his 7th

season in Portillo.  His mountaineering
has taken him all over the world with
many expeditions in the Himalayas and
the Andes.  This isn’t his first rodeo.  Like
many of us, Frank was schooled in
American snow standards, but after
taking Canadian Level II years ago his
classification of
snow/avalanches/weather has taken on
a more northern worldview.

Coffey’s first season forecasting in
Portillo was spent “figuring things out.”
Most of his time was in the field
observing and riding the big learning
curve.  He sure isn’t an office-bound desk-
jockey, but an old-school field hand who
spends 90% of his time on skis using his
patroller’s legs, his hands and shovel to
get the “feel” of his snowpack.  

I made my way up the Aconcagua
Valley after a week of acclimatization at
Lane’s place in Rio Blanco with Mark
Rawsthorne-The Brit, who is  Lane’s
neighbor, my friend and part of Coffey’s
p a t rol/snow safety team at Portillo.
Mark had spent parts of three seasons
with me on Red Mountain Pass sweeping
storm boards, skiing the San Juans and
learning to fear a continental snowpack.
His new six-month-old Golden,
“Reginaldo”, avalanche rescue dog in
training, was in the back of his girlfriend’s
Toyota sweeping back and forth catching
all the smells.  We unloaded in Portillo at
the old train station that had been
converted into a rustic home for senior
employees.  Coffey greeted us, we high
five’d and hugged like old women.  It had
been a couple of years since we’d spent
time together.

Portillo is set at 2,980 meters in a high
alpine basin, the start of the Valle De
Aconcagua.  Much of the basin is filled
with Laguna Del Inca and towering above
the yellow Mother Ship, Hotel Portillo,
are 5,000 meter peaks with steep rock
walls and intimidating avalanche paths
that fall onto the lake and the piste.  A
skiers dream… and a fore c a s t e r s
nightmare… At 6,959 meters Aconcagua
sits above Portillo on the border with
Argentina.  Can’t compare ski areas in
North America to Portillo.  The climate is
California.  Portillo experiences
something between maritime and
intermountain climate, depending upon
the year and elevation.  When you drop
30 switchbacks and 1,400 meters into the
valley there are vineyards and orchards,
all in a thirty-minute drive.  

We eventually made it over to
Frank’s office in the lower level of the
hotel to look at  weather maps of a big
storm brewing off the coast that looked
days away.  I asked,  “Is this a Fourth of
July storm?”  Frank replied, “Naah, looks
like a few days later.”  While staring at the
screen we found the Unisys web page,
which had a South American component.
The AVN model had the storm looking
large and juicy.  We shared interpretations
of the vorticity and precip maps.  It is a
good addition to the NOAA site and
Meterologia de Chile but the pronostico
de metero rologias for the southern
h e m i s p h e re seemed scarce, pro b a b l y
because North American computer
s c reens are saturated with too much
information.

Lane had warned me of the batting
average the meteorologists had acquired
for the early season.  They were in a
slump.  But wrong 60-70 % of the
time??… How can that be?…Lane
qualified his Gato Negro wisdom. “That
includes all of the weather forecasts put
out, CNN, The Weather Channel, NOAA,
M e t e rologica de Chile, A c c u We a t h e r. ”
But Lane was badmouthing NOAA and
was caught not entering the slash in front
of the longitude/latitude coordinates for
the southern hemisphere.  He was
watching rainstorms in the Bahamas!  I
appreciate a decent weather forecast or at
least a good satellite photo of the 24-hour
future.  This worried me…. I’d heard
rumors of a spiritual weather forecaster
down valley in a local campo that took in
laundry and possessed her own
methodology for forecasting.  I had to
find her…

Maria, pronostico de campo
by guessing or wisdom

forecast July storm

I arrived in the campo early, Maria
went out and got the rooster tied with
prudent foresight, to the lemon tree in the
yard to sacrifice him to the Orixas. This is
when I realized that because of my ability
to make “being absolutely wrong all the
time” an art form, according to an old
girlfriend, I had to put my money on the
p ronsticos of Maria.  Her “pre s e n c e ”
filled the dimly lit room.  She had been
correct with all of her weather forecasts
by throwing her seashells and reading
cocoa leaves, but until I gave her four
kilos of dirty laundry, she wouldn’t give
me the forecast.  A visiting lady friend
told me upon picking up her wash, that
Maria had mentioned “they” when
questioned about the weather.  I had to
assume that it was communication with
her spirit world.  Anyway, the woman
was right more than she was wrong so
with my many pilgrimages to her shack
and subsequent return to Portillo, my
fellow snow viewers and weather
watchers could hardly wait for the
Forecast and stories of Maria. 

Wed. 2/7/03
We begin the day early in Frank’s

office watching a series of storms work
their way onshore and dig southeast into
the central Andes on satellite.  Not big
storms, but ones that could produce a
meter or two of snow.  We go out to the
Roca Jack lift, a five-person poma that
deposits us on a icy 35-degree slope,
wondering who gets off first?  With luck it
is only the two of us.  We ski out on the
Traverse, a fast, icy track that travels
above steep, cliff-strewn descents with
names like The S Chute, El Estado,
K i l o m e t ro Lanzado and Primera
Quebrada.  Oooh, don’t want to fall here.
No stopping until the bottom, 300 meters
below..  Listening to what is important to
Paco.  Upper layer slabs, crusts and grain
types.  There are small (0.5mm) facets on
the shady southern aspects today, but
with the 8-degree C temps they don’t
seem to be a problem.. He takes his
thermometer out for the tenth time.

Another air temp.  Seeing melt water
running on the rock bands above the area
puckers him.  He generally closes the
traverse with its eastern sun when 8-10 C
is reached.  With a rapid warm-up he sits
beneath the Roca Jack and worries with
his disciples, Mark Rawsthorne and Jorge
Sepulveda.  

Jesus!  Most of Paco’s terrain has near
vertical cliff bands is broken by large
paths that pour onto the piste.  Seems to
eliminate slab formation because they are
cleaned out by avalanche debris fro m
above, but Frank worries about the flanks
of his paths that are not swept by this
natural avalanche control.  He takes care
of those areas after the storms.  But with
all this rock his hands are full with loose
and loose/wet slides from heating rock
and major rock avalanches.  His face
wrinkles with concern with 20-cm. or
m o re of new snow.  He continually
observes and writes in his yellow book.

Thurs.  3/7/03
On the traverse again.  Back to

problems.  Large and persistent grains
bother Frank.  Graupel, surface hoar and
facets (when cold enough) found beneath
the slab get his attention.  Especially if
there has been early May snow followed
by weeks of clear/cold weather.  We dig a
pit to the ground above Primera
Quebrada.  Over two and a half meters.  It
looks pretty much the same to me.  Stable
as a Mormon marriage; however, Frank
points out a minor concern near the
surface with a shovel tilt test.  Fails with
several taps, but will probably tighten up
with the day’s warming air temps.  We
look at a cornice looming 1,000 meters
above us.  Frank started heli-bombing the
cornice that forms from NW winds a few
years back.  It’s large and would cause
death and destruction if it hit the ski area.
Frank told me, “I went to the lenceria
(laundry) and got some used pillow cases
to put the hand charges (6-12 kilos) in for
friction.  Didn’t want them slipping off
the cornice and into the gullies or rock
bands.  It worked, so I went back for more
and the lady running the show refused to
give them to me.  She said,  ‘I already
gave you some.’  Henry got it
straightened out pretty quickly.”

Fri.  4/7/03
Cold last night and we have a few

cm. of new on July 4th.  Unisys has good
vorticity and RH for the next few days.
Skied all day with Frank, watching the
new snow point release out of the cliffs

causing him to close the Traverse early
because the cold new snow isn’t sticking
to the old icy surface and with the rocks
above holding snow that could hit certain
runs.  Reopened at noon with rising
air/snow temps causing settlement.  Go
to the office and check the Campbell for
temps/RH again.  Wa t c h i n g
geostationery satellite and vorticities.
Very unstable, wet air.  Isobars spaced,
and little wind.  Unusual for Andean
storms.  Off to Tio Bob’s for lunch and the
afternoon beauty contest.  The hardships
of Coffey’s World.  

Sat.  5/7/03
cranky snow guru
observes meter crown-
fear and disgust
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PISCO DREAMS-CHILE POWDER
By Jerry Roberts

Results of helicopter bombing of a cornice above Portillo. 
Photo by Matthew Wylie.
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From: Frank Coffey
To: snowviewer@montrose.net
Sent: Wednesday, October 08, 2003 4:45
PM

Roberts,

Wednesday afternoon, the day after
the first day of my vacation. This
morning was painful. Spent last night
with Rob Rogan, Jakubik, and Manns
sucking down vino tinto and feasting on
carne at Hugo and Matilde’s home in
Santiago. Hugo, the consummate
Argentine, proved to us once again that
the Argentines are the asado masters.

Read the article. I like it. First,
spelling corre c t i o n s : Chugach and
oficina.

Now the brick story. The bottom of
Roca Jack lift sits at the bottom of a 4,000
foot slide path. The path runs often and
repeatedly during storms. The path has
run to the lake twice, size 4.5, dropping
4,700 feet. In 1965 after a 7 meter storm it
ran to the lake. In 2001 after a 1.5 meter
storm, a cornice triggered a size 4.5 soft
slab which again turned left at the
bottom of Roca Jack run and fell another
700 feet to the lake.

As you know, I told Henry when I
first came to Portillo that the corniced
ridgeline that sits above the Roca Jack
was my single biggest concern. The Roca
has been taken out 6 times in my 7 years
in Portillo. The Va et Vient... comes and
goes ... lift is perfect for that
location. When the lift is hit, most often
the cable is knocked off the free standing
bull wheels that are connected to the rock
buttresses at the border. The cable is
buried by debris and we either pull it out
with a snowcat or if that is not possible,
long line another cable up with the heli
and reassemble the lift. Process takes
about 3 to 7 days. If the lift towers at the
bottom of Roca are hit and damaged, the
process may take longer.

The 2001 avalanche took out the
Roca and also damaged the La Laguna
lift. After that incident Henry and I began
to talk in earnest about what options
were at our disposal for mitigating the
threat of the Roca cornices. Heli bombing
was the only logical option. Military
weapons in Chile were out of the

question, avalaunchers - not enough
range or accuracy, snow fencing - the
ridge was too narrow, blaster boxes - too
expensive. I learned my heli bombing
licks from two masters, Dave Hamre and
Chris Stethem. Stethem suggested 12 to
25 kilo charges wrapped in a pillow
cases to provide more friction. Henry
did not like the idea of a large charge
cascading down the slope toward his
signature lift.

The shot placements are tricky. Most
of the cornices tend to be hard packed
and sloping. I test the snow first with a
one kilo brick. If the snow is soft enough
to hold the charge, I toss out the charge
after the brick test. This procedure is
somewhat complicated by the fact that
we are lighting the safety fuse with
matches with the heli door in my side
open. Pull wire ignitors are illegal in
Chile... concerns of terrorism.

In 2002 on our third heli bombing
mission of the season I have Henry
o n b o a rd. You know Henry; he is a
“hands on” kind of boss. My usual
assistant, Chico Mora, who can light a
charge with a match in gale force winds,
had the day off. Per usual, I throw out
my brick to test the snow. The pressure
was on, boss onboard. The brick
triggered a 2.5 avalanche, not big by Roca
Jack standards. Henry and Mario, the
pilot, did not realize what had
happened. I instructed the pilot to fly
away from our location. We w e re
hovering above the cornice at 13,700
feet. He was confused because I still
have a 12 kilo charge in my lap. As we
flew away from the ridgeline we saw
the avalanche racing toward the Roca
Jack. Henry asked the obvious question.
“Why are we using explosives for this
cornice work?” Explosives, inexpensive
in Chile by American standards, are still
pricier than bricks.

Roberts, I hope this helps. I will check my
email first thing Thursday AM. Please
fire off any questions. I hope all is well
with you, amigo.

Un gran abrazo
Paco

25 cm overnight, 6% water!  Is this
Chile or Colorado??  Roca Jack, Traverse
and Plateau—Cerrado/Closed.  The
pressure is off.  Frank, Henry, and the
patrol head out to work.  White out
conditions, but can hear cascading snow
released from the Condor wall rushing
onto the Plateau from avalauncher work.
One shot into the main gully releases a
large slab that is heading uncomfortably
toward us gathered at the avalauncher
platform.  Henry calmly suggests that we
cover up.  We all bend over in unison to
take our punishment from a larg e
powder cloud that lasts 20 seconds.  You
gotta believe!  I trust Henry’s experience.
Next, hand charge routes on the
Gargantitas and ski cuts that get good
results.  Shit, a dud in the Gargantita
cliffs!  

Frank descends carefully into the
upper Gargantita to retrieve the dud and
triggers a meter slab onto the piste below.
He’s stuck on a 40-degree bed surface of
no return.  Can’t go up and can’t
descend.  I watch from below with Jorge
giving our best options for retreat.  A
fixed line is dropped and he jumars back
to civilization.  Too close for me and
especially for Frank.  What’s the sage
advise?  Experience is just a series of
nonfatal errors.. But so deep into middle
age?…  They get the area back again
except for Roca and the Traverse.  Coffey
and I walk across the Pan A m e r i c a n
highway to the Posada for counseling.
He’s still on an adrenalin buzz from his
near miss.  6 cm. an hour dendrites fall as
we enter the warmth of the Posada for
lomo probre and a pisco sour.

late night pisco      
enlightenment
La Posada bar

Sun.  6/7/03
Another 56 cm overnight of 14%.

Inverted storm!  I meet Frank in the office
at 5 a.m.  The area is closed and so is the
Pan American.  Very quiet, no tru c k
traffic.  Henry comes in and we look at
Campbell information and other
forecasts as he shares a story. “Monty
Atwater was our forecaster in 1966 for
the first World Speed Skiing
Championships.  The President of Chile
was visiting and wanted to meet an
avalanche expert so I took him over to
Monty’s room.  Eventually the
conversation got around to control work
and the President asked where he kept
the explosives.  A smile crossed Monty’s
face as he pointed and said, ‘Why, under
my bed.’”  A c c o rding to Henry, the
executive’s retreat was “very rapid.”

Mon.  7/7/03
Avalanchista chews toothpick
and worries.
July storm

20 cm more overnight.  Tim Lane
calls from the Andena and reports two
meters at the mine at 4,500 meters.   Says
his meteorologist is calling for storm
intensity to increase by mid-
day…Snowing 8 cm/hr. Another 40 cm
since 7 a.m.  13% with wind.  Starting to
get ugly.  Visibility is poor until a break
allows us to get control work started
with the avalauncher and control routes.
As Frank says,  “Most of the control work
is done by the storm.”  You can hear
avalanches running on both sides of the
valley.  Coffey decimates a small aspen
forest with his toothpick habit.  High
anxiety! 

Tue.  8/7/03
06:30.  High winds and snow all

night.  Hazard is high and rising…  The
storm stalls over the Andes with dying
winds in its low-pressure spin.  Snowing
4 cm/hr , but density is decreasing with
dendrites.  We’ve gotten over 200 cm.
The books that I’ve read and experience
tells me, widespread slab activity, but I
see almost none!  Of course direct action
activity ran its course.  I talk with Lane
and Coffey.  “We have over half a meter
of dendrites followed by 13% snow with
wind and ending with Colorado powder
and little wind. Why aren’t we seeing big

slabs?”  Lane suggests,
“Throw out the books and
everything we’ve learned.”
Frank, a little spaced
replies,  “People ask me
what I do around here all
day?-I WORRY!!”

Wed.  9/7/03
Dug pits and skied a

few runs.  Class III and IV
avalanches (Canadian).
R e i n f o rcement that these
major paths do run during
the storms, cleaning
themselves out, but the
flanks are still suspect.
With all the water and warm
temperatures, the pack stabilizes rapidly.
This snowpack heals quickly.  I’m ruined
by a continental climate.  

Thur.  10/7/03
Setting on my mochila high in the

Madrones Valley across the way from
Portillo.  Aconcagua and Juncal peaks
tower above me while I spot Frank as he
digs the first of many pits in preparation
for heli-ski clients tomorrow.  Looking
down at 1,500 meters of untracked.
Maybe put our signatures on the slope if
we have stability.  Silence surrounds me
with only an occasional grunt fro m
C o ffey moving snow.  Half dozen
condors circle above looking for fresh
meat.  Frank skis across the basin to
another aspect and I drop to the pit and
inspect.  Moderate shears one meter
down on a 3 cm graupel layer.
Hummm…I’m not convinced.  “Coffey,
whadda think?  A 35-degree slope.  We
could mine this graupel..”  Frank smiles,
“A little paranoid Colorado boy?  The
two meters that dropped here was a
p retty big shock.  There are ro u n d s
mixed in with the graupel with good
bonding and warm snow/air temps.”
He’s had seven seasons down here.  Ski
one at a time from cliff band to dome to
lower angle slopes to the landing zone.
Some fine powder turns to valley
bottom.  Encantado!  (Charmed)

Fri.  11/7/03
Perched on Madrones valley ridge. 
500 July turns

Almost missed it!  I avoid the
oficina on heli-ski days.  Too much
commotion and I’m in the way.  I show
up around nine and Jorge asks,  “Where
have you been?  Frank’s looking for
you.”  A radio transmission later,
“Roberts, this is Coffey, you wanna ride
drag on this cattle drive with me and two
clients?”   I reply, “Huhhh, sure.”  I boot
up, grab my skis and pack and hustle to
the heli-port.  Six lifts and 5,000 meters
later I have maybe the best ski day of my
life!  This wasn’t a Pisco Dream-it was
pure Chile powder…

THE END
That’s it.  I spent the season in

Portillo with my buddies, had big fun,
drank some good wine and learned from
The Master, one of the best in the
business.  He taught me a lot.  He shared
his knowledge and experiences.  I owe
him.  Chairman Mao said:  “Re-
education is necessary.”  So I followed
the footsteps of Frank Coff e y,
Avalanchista de Portillo.  And the
“Work” of the work/study program?  I
hope it was a good trade for Henry and a
contribution to Portillo’s avalanche
program.  Mark Rawsthorne was the skill
behind the idea.  I thank him.  Salude!
The computer in Paco’s office hasn’t
seized up yet and I’ve got 3 seasons of
data entered!  “Hey Henry, how about a
avalanche atlas next year?”

Jerry Roberts is CAIC/CDOT forecaster on
Red Mtn. Pass, Prescott College adjunct
p ro f e s s o r, consultant/forecaster for the
Chilean mining industry, AAA certification
administrator (beaurocat as in Ghetto speak),
spiritual advisor and window washing.

1. Frank Coffey in his officena.  2. A control team
waits for the punishment. 3. Frank Coffee and Matt
Wiley starting the traverse.  4. An avalanche runs
off the rock wall above the plateau. 5. The Roca
Jack at Portillo Ski Area.  Photos 1,2,3,4 by Jerry
Roberts, photo 5 by Matthew Wylie.
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azakhstan is a new indepen-
dent republic in Central Asia,
located between Russia,

China, Kyrgyzstan, Uzbekistan, and
Turkmenistan. Its area is 2,670,806
km2 with a population of 15.8 million
people. Mountain regions with
avalanche hazard are concentrated at
eastern part of Kazakhstan. There are
the Altai, Saur, Tarbagatai, Dzungar
and Alatau mountain ranges, and the
Northern and Western Tien Shan
Mountains. The total area of haz-
ardous avalanche terrain is 134,000
km2. Most mountain ranges are ori-
ented in an east-west direction. Plains
that surround the mountains have
altitudes of 300 – 600 m above sea
level. Altitudes of the mountains
from north to south are: Altai – 3000
m, Dzungar Alatau – 4000 m, Tien
Shan – 5000 m. The highest summit
peak is Khan Tengry with an altitude
of 6997 m. 

A common altitudinal landscape
structure from lowest to highest is
deciduous forest, coniferous fore s t ,
alpine meadows, high mountain tun-
dra; and stones, snow fields and
glaciers. The treeline rises from 2000
m in Altai in the south, to 2400 m in
Dzungar Alatau, and to 2800 m at The
Northern Tien Shan.

The climate is strongly continen-
tal in Kazakhstan. Moisture travels
from the North Atlantic Ocean. The
world’s highest mountain barrier:
Hindukhush – Karokoram –
Himalayas isolates the Kazakhstan
mountains from the Indian Ocean.
Plains with steppes and deserts
receive only 100 – 300 mm precipita-
tion in a year. In the mountains annu-
al precipitation increases to 600 – 800
mm, and to more than 1000 mm in
glacier zone. Spatial precipitation dis-
tribution depends on the slope orien-
tation of the range. The western
edges of the mountain ranges receive
maximum moisture – up to 2000 mm
in the Western Altai and Dzungar
Alatau. On eastern sides of the moun-
tain ranges annual pre c i p i t a t i o n
decreases to 200 – 400 mm. Maximum
p recipitation occurs during spring,
April – May (Figure 1). A second

smaller peak of precipitation happens
November – December. Summer and
winter are very dry. Summer is hot,
and winter is cold.

The mountains are snow covered
from November to April, and year
round in the glacier zone Snow depth
depends on altitude and slope aspect.
On northern slopes in the coniferous
forest and alpine meadow zones in
the most mountainous regions annu-
al maximum snow depth is 100 – 120
In the Western Dzungar Alatau snow
depth increases to 200 cm, and in the
Western Altai reaches 300 cm.

After the autumn, snowfalls form
a 50 – 60 cm snow cover on the
ground. The lengthy midwinter dry
and cold period starts, forming a
weak snow layer with large (3 – 5
mm) depth hoar crystals at the lower
part of the snowpack. Spring snow-
storms create 40 – 50 cm snow slabs
above this weak layer and trigger
avalanches. Increasing density and
decreasing strength in the direction
from snow surface to ground is the
typical feature of snow cover struc-
ture.

T h e re are about 30 days with
snowfall during winter period. Most
snowfalls are small, less then 10 cm of
new snow. Snowfalls of 30 – 40 cm
usually occur one time in winter.
Heavy snowfalls greater than 70 cm
new snow occur one time in 50 years.
The duration of most snowfalls is
usually 6 – 12 hours. Snowfall intensi-
ties are about 1 cm/hr in winter and 2
cm/hr in spring. New snow density
is 50 – 80 kg/m3 in winter and 100 –
150 kg/m3 in spring.

About 30 – 40 days with
avalanches account for 10 - 15
avalanche cycles during the winter
period. Causes are usually snowfall
events in winter and thaws and
snowmelt in spring. Most of the
avalanche cycles last 2 – 3 days, but in
late spring avalanches may descend
each day during two weeks.

About 80 % of the avalanches
occur during or just after snowfall or
rain on snow.  There are two peaks of
avalanche activity during winter: 1)
at the end of December – the begin-

ning of January with dry loose snow
avalanches, 2) at the end of March –
April with wet slab snow avalanches.
Dry avalanches prevail in number,
but wet avalanches are the biggest
and most destructive. Avalanche ver-
tical drop height reaches 1000 m and
travel distance reaches 3500 m. The
maximum re c o rded avalanche vol-
ume is 350,000 m3, and average vol-
umes are 10,000 – 15,000 m3. Wet

avalanches move with velocity 10 –
15 m/sec.  Dry avalanches have
velocities 30 – 50 m/s. Flow height of
wet avalanches is usually 3 – 6 m.
Flow height of dry avalanches may
reach 20 – 30 m. In the snowiest
regions of the Western Dzungar
Alatau and the Western A l t a i
avalanche volumes can reach one
million m3, and avalanche flow
heights reach 150 – 200 m. The biggest
avalanches run up opposite valley
slopes to a height of 200 m. 

Avalanche activity varies strong-
ly year to year (Fig. 2). The number of
days with avalanches, the avalanche
number, and the total avalanche vol-
umes increase in general with the
snow amount (annual maximum
snow height). Winters with high
avalanche activity return each 10
years. Sometimes a year with high
avalanche activity corresponds with
snow amount less than normal and
vice versa depending on specific
snow cover development. During the
last 30 years slight positive trends are
estimated for both the snow height
and the avalanche volume sum.

Avalanche hazard characteristics
differ greatly across altitudinal zones
(Table). Avalanche volumes and the
share of area hit by avalanche have
maximum values in the upper part of
the conifer zone and in the alpine
meadow zone. A dense fore s t
impedes avalanching in the lower
part of the coniferous zone although
snow height is sufficient here for
avalanching at the open slopes. In
high mountain tundra and glacier
zones avalanche activity is high but
avalanche hazard is less than in the
alpine meadow zone since valley bot-
toms are wide; the amount of area hit

by avalanche decreases to 30 – 50 %. 
The mountain regions of

Kazakhstan are sparsely populated
and little developed; therefore, dam-
age from avalanches is low. There are
some mines and miner settlements hit
by avalanches in Altai, Dzungar
Alatau, and Karatau. A railroad and
some roads in the Altai are threatened
by avalanches. The main avalanche
problems exist in Zailiyskiy Alatau

range. The biggest state city, Almaty,
with 1.5 million people is located on
the northern foothill of this range.
Many people visit these mountains
for skiing, climbing and hiking in
winter. The only Kazakhstan ski area
“Chymbulak”, is nearby. There is also
the famous high mountain skating
ring “Medeu”, and several recreation
areas in the Zailiyskiy Alatau. During
the last 25 years avalanches killed 50
people (tourists, climbers and skiers).
The annual death toll has reached as
many as 12 people. As the number of
winter visitors increases; the
avalanche problem is expected to
become more significant. 

Avalanche investigations in
Kazakhstan began in the 1950s in the
Institute of Geography of Kazakh
Academy of Science. In the 1960s the
M e t e o rological Service established
five avalanche observation stations
(one in Altai, two in Dzungar Alatau,
and two in Zailiyskiy Alatau). Now
only two stations in Zailiyskiy Alatau
operate. They are “Shymbulak” and
“Big Alamty Lake” located respec-
tively at 2200 and 2500 m. The mis-
sion of the station’s staffs includes
weather observation, measurement of
snow cover properties, re c o rd i n g
avalanche events, and local
avalanche forecasting. Daily shear
and tension frame measurements are
recorded at the study plots near the
stations. Empirical dependencies of
avalanche formation probability on
snow cover properties and the new
snow height or air temperatures are
used for forecasts. Since 2000, the
Swiss nearest neighbors computer
program NXD has helped forecasters
in decision-making procedures. 

The Avalanche Information

Figure 1. Monthly distribution of precipitation in Zailiyskiy Alatau range.

Figure 2. Yearly variations of the annual maximum snow height and the total
avalanche volumes in Zailiyskiy Alatau range at altitudes 2500 – 3200 m. (data
from the Chymbulak Avalanche Observation Station).

Avalanche Hazard in Kazakhstan

By Viktor Blagovechshenskiy

K



Center of the State Meteoro l o g i c a l
Office in Almaty produces regional
avalanche forecasts for all the moun-
tainous regions of Kazakhstan. The
data from avalanche observation sta-
tions, mountain weather stations and
estimated amount of new snow and
air temperature from the region are
used in creating avalanche forecasts.

The Institute of Geography stud-
ies the spatial distribution of
avalanches, develops methods of
avalanche hazard estimation and
mapping, and draws up avalanche
h a z a rd maps. Specialists of the
Institute have developed methods for
compiling small scale overview, mid-
dle scale regional, and large scale
engineering avalanche hazard maps.

The Emergency Committee with
the Defense Department and the
Rescue Service prevents and miti-
gates damage from avalanches.
Avalanche warnings, mountain area
access limitation and closure, and
avalanche artificial release are used.
About ten avalanche paths that hit ski
runs, roads, and tourist trails are con-
trolled. Only hand placed explosive
charges are used for avalanche con-
trol. Artificial releases are produced

usually twice during winter: at the
end of December and at the begin-
ning of March. There are few engi-
neered protective structures in the
Kazakhstan mountains. Snow sup-
port fences had been constructed in
the 1970’s to protect the skate ring
“Medeu” near Almaty and a mine
site in Dzungar Alatau. There are no
recent defense structures and none
are planned.
Viktor Blagovechshenskiy is head of the
Laboratory of Mountain Ecology of the
Institute of Geography of Kazakhstan. He
is a Doctor of Geography Sciences. He
has studied avalanches for about 30 years
in Tien Shan, Altai, Pamirs, Caucasus,
and Khibiny. He is the author of more
than 80 scientific papers and 4 mono -
graphs concerning problems of avalanche
hazard mapping and avalanche parame -
ter calculation. He worked at  Montana
State University from February to May
2003 and applied his experience to create
the Avalanche Sites Atlas for the Bridger
Range, MT.

Contact information: Institute of
Geography, Pushkin St., 99, 480100
Almaty, Kazakhstan, ingeo@mail.kz.
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Another story about poor skills
came from expert skiers. And one
story, where Steve and his friends
were in the wrong place at the
wrong time, came from people
who knew very little or very
much about avalanches. In other
words, each person perceived the
accident in terms that tended to
confirm their preexisting beliefs.
The details of the accident
weren’t quite as important as the
very human need for people to
tell stories that implied “It
wouldn’t have happened to me.”

Years have passed, and the
details of the accident have
mostly faded. What remains are
the stories that people tell, stories
with the implied moral that if
you learn about avalanches and
think rationally you’ll stay alive
in avalanche terrain. There isn’t
much room in these stories for
trained, rational people who are
certain they are safe but get killed
anyway. There isn’t much room
for looking at something,
whether it is an avalanche slope
or the death of a friend, and
seeing not some objective reality
but a reflection of your own
biases and expectations. A n d
there isn’t much room in these
stories for the possibility that the
line between our own decisions
in avalanche terrain and those
that lead to accidents may, all too
often, be very fine indeed.

In this two-part article, we’ll
explore some of the reasons why
accidents like the one that took
Steve’s life happen. To do this,
we’ll have to go beyond simply
labeling victims’ decisions as
foolish, ignorant or egotistical.
And we’ll have to go beyond the
temptation to see avalanche
accidents as a failure of logic,
reason or education. To
understand why avalanche
accidents happen, we’ll need to
look at human decision making
itself and how, despite its power
and flexibility, it can pose very
subtle and very compelling traps.
By reviewing aspects of cognitive
science and statistics fro m
recreational avalanche accidents,
we’ll see that many avalanche
victims may have fallen prey to

six decisional cues related to
f a m i l i a r i t y, social factors, and
gender roles. For each of these
cues, we’ll look at which
re c reationists were most
susceptible based on their level
of training and the size of their
p a r t y, and examine why these
susceptibilities exist. Finally,
we’ll look at what all this means
for avalanche education.

Let’s begin by taking a close
look at how our perceptions form
the basis of our decisions.

Human perception and decision
making

Most of us like to think of
ourselves as basically unbiased.
We believe we perceive the world
pretty much as it really is, and
only occasionally fall prey to
illusions that trick us into making
mistakes. But the truth is that our
p e rceptions are gre a t l y
influenced by subjective factors.
Whether what lies before us is a
book, a table, or an avalanche
slope, what we end up
perceiving is a combination of
what our eyes tell us, what our
past experience has been, and

what we expect to see. In other
w o rds, perception is not a
passive process where the world
reveals itself to us, but an active
process where we construct an

interpretation of the world.i

You can experience this process
for yourself in Figure 1. In the
upper half of the drawing, your
brain creates the expectation of a
table with four legs. In the lower
half of the drawing, you expect a
table with six legs (try covering
up each half to get the full effect).
Because both interpre t a t i o n s
cannot simultaneously be true,
your brain experiences a kind of
tug-of-war between what you see
and what you expect to see. The
result is a revealing (if
disturbing) demonstration of just
how insistent our brains are in
p rojecting expectations onto
what we see.

P e rception in avalanche
terrain is much the same. Far
f rom being “objective,”
avalanche experts are probably
highly influenced by their
expectations of terrain and snow

continued from cover.
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conditions. Because they have a
l a rge mental warehouse of
experiences, they can
unconsciously “fill in the blanks”
and construct a mental image of
avalanche conditions even when
their initial information is
incomplete. Just as we recognize
some basic features of a table in
F i g u re 1 and mentally try to
c o n s t ruct an image consistent
with our expectations, the
avalanche expert recognizes the
basic features of a familiar pattern
in avalanche conditions and
c o n s t ructs a mental picture
consistent with those familiar
patterns.  The more experience the
expert has, the more accurate their
mental picture, and the more

successful their decisions will be.ii

That’s why exhorting students in
your avalanche courses to “be
objective” about the avalanche
conditions will often get you
blank stares – they lack the
experience to flesh out a mental
picture that may be crystal clear to
you.

Alas, most people have vastly
g reater experience with things
like tables than they do with
avalanche conditions. So how do
most people make decisions in
avalanche terrain? One school of
thought proposes a systematic
process of evaluating all relevant
information and selecting the best
course of action. Though this
approach sounds good in theory,
in practice it requires considerable
expertise to correctly identify the
relevant decision factors and
accurately interpret avalanche

c o n d i t i o n s .i i i A far more likely
candidate is the decision strategy
espoused by modern researchers
who study decision making under
uncertainty: in the absence of
simple probabilistic tools, people
tend to rely on ad-hoc rules, or
heuristics, that are based on

familiar situational cues.iv

Of course, heuristics are only
as good as the cues that trigger
them. For example, in unfamiliar
social situations, most of us have
learned to look at what other
people are doing as a fairly
reliable guide to what behavior is
a p p ropriate for us in that
situation. Here, the situational cue
(what others are doing) guides

our decision (to act in the same
way as others). Most of the time
this heuristic is correct, and we
behave appropriately. But at other
times, such when the people
around us are engaged in illegal
or self-destructive behavior, this
same heuristic can lead to disaster.
This kind of situation, where we
rely on the wrong cue to guide our
decisions and our behavior, is
known as a heuristic trap.

Six heuristic traps are notable
for their ubiquity in human
decision making: familiarity,
acceptance, commitment, the
expert halo, scarcity and social

consensus.v To determine if these
traps played a role in the decision
making of avalanche victims, I
reviewed 715 U.S. accidents (1972
– 2003) and compared decisions
that victims made either in the
p resence or in the absence of
heuristic trap cues. To minimize
documentation biases and to
remove any org a n i z a t i o n a l
influences, I considered only
re c reational accidents and
excluded from the study accidents
that occurred on commerc i a l l y
guided trips, club outings, in
work settings or on highways.
Data for the study came fro m
re c o rds maintained by the
Colorado Avalanche Information
Center, published accounts in the
Snowy To r re n t s ( Williams and
A r m s t rong, 1984; Logan and
Atkins, 1996), the We s t w i d e
Avalanche Network, the
Cyberspace Snow and Avalanche
Center, avalanche forecast center
annual reports, and various
Internet and newspaper
resources.

Evaluating decisions by
avalanche victims

In cases where the trigger was
known, 93% of the accidents in
this study were started by the
accident victims or by someone in
their party. Thus most accidents
resulted from a specific decision:
the decision to enter the path that
eventually avalanched. Rather
than try to re c o n s t ruct and
examine each decision, I looked
instead at the circ u m s t a n c e s
under which each decision was
made. My underlying assumption
was that, on average, victims who
took more risk would have made

the decision to enter the avalanche
path when evidence of the
avalanche hazard was more
apparent. So for each accident, I
computed an exposure score that
roughly quantified the amount of
hazard present at the time of the
decision (Table 1). To minimize
reporting biases, I chose
indicators that would have been
a p p a rent to any observant
individual at the time of the

accidentvi. In many cases, hazard
indicators were reported by
rescue parties or investigators
rather than the victims
themselves, further re d u c i n g
(though not entirely eliminating)
reporting biases. I assumed that
any remaining reporting biases
were uniformly distributed across
all accident groups.

Because the frequency of
hazard indicators was unknown
for cases where accidents did not
happen (the non-event base rates),
it wasn’t possible to determine the
relative significance of the factors
in Table 1. Thus, I gave each
indicator the same weight and
computed the exposure score as a
simple linear sum of all of the
h a z a rd indicators that were
known to be present at the time of
the accident. A m o re
comprehensive description of the
rationale behind computed
exposure scores can be found in
McCammon (2000).

The overall distribution of
exposure scores shows that most
victims proceeded onto the slope
in the face of ample evidence of
danger (Figure 2). Over 73% of all
accidents occurred when there
w e re three or more obvious
indicators of the hazard (median
e x p o s u re score = 3 indicators).
This finding is consistent with the
f requent observation that many
avalanche victims appear to have
i g n o red obvious signs of
instability (Fesler, 1980; Smutek,
1980; Jamieson, 1996; Atkins, 2000;
Tremper, 2001).

Because Figure 2 includes data
from accidents where very few
details were known, and because
accident reports didn’t always
p rovide complete information
about all the hazard indicators
that may have been present, the
distribution is almost certainly
skewed to lower values by under
reporting. Thus, actual exposure

scores for recreational accidents
were probably higher than shown
(median exposure score > 3),
further raising the certainty that
most victims had ample evidence
of the hazard at the time of their
decision. There were no cases in
the data set where all of the
hazard indicators were known to
be absent. Thus, accidents where
there was little or no evidence of
the hazard prior to the avalanche
appeared to be quite rare.

Averaged across gro u p s ,
exposure scores roughly quantify
the risks taken by avalanche
victims at the time of each
accident. So, if victims were
influenced by heuristic traps, we
would expect accident parties to
have higher exposure scores when
heuristic trap cues were present
than when such cues were absent.
But sensitivity to these traps
might vary according to other
factors, such as training and
group size.

Decision making and training in
avalanche accidents

Conventional wisdom
suggests that recreationists with
high levels of avalanche training
are pretty skilled at their sport. So
these individuals would be more
likely to seek out steeper and
m o re avalanche prone terrain
than re c reationists with less
training. But in obviously
dangerous conditions, we would
expect the more highly trained
folks to recognize the hazard and
avoid such places. In other words,
we’d expect average exposure
score to go down as avalanche
training goes up. Does it?

To answer this question, I
defined the training level of each
accident party to be the training
level of the most skilled person in
the party (Table 2). To avoid
deliberately linking training
categories to hazard scores, I
didn’t consider terrain avoidance
p recautions to be a training
d i s c r i m i n a t o r. Remarkably,
e x p o s u re scores of the four
training categories showed no

significant diff e re n c e sv i i

(pANOVA = 0.62). This result was

robust with re g a rd to age
differences since exposure scores
for victims aged < 20 years, 21–25
years, 26–30 years, 31–25 years,
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>36 years showed no statistically
significant difference (pANOVA =

0.42). The result was also robust
with regard to activity type, since
activities that showed very high
or very low exposure score s
accounted for less than 10% of all
accidents (Figure 3). The central
90% of all activities showed no
significant differences in exposure
scores (pANOVA = 0.24).

The bottom line is that
avalanche training did not
correlate with a reduction in the
overall risk taken by avalanche

victims.viii While it is important
to note that this result applies
only to a very select group of
people (those caught in
avalanches), it has important
implications for avalanche
education, as we’ll see in part 2 of
this article. For now, however, all
we need to recognize is that any
variations in exposure score s
among training categories must
be due to variables other than the
age of the victims and the type of
activity they were engaged in.

Decision making and party size in
avalanche accidents

In a survey covering ten years
of avalanche accidents, A t k i n s
(2000) showed that parties of two
and three people were more
commonly involved in accidents
than parties of five or six people.
But how much of their
involvement was due to greater
risk taking by the smaller groups,
and how much was due to the fact
that smaller groups are more
common in the backcountry? A
look at the exposure scores of
different party sizes gives a rough
estimate of the re l a t i o n s h i p
between risk taking and party
size.

In this study, party size and
exposure score were known in 631
accidents. Figure 4 shows the
mean exposure score for each
party size, along with the 95%
confidence intervals for the means
(all score distributions were
normal). It appears that people
traveling alone and people
traveling in parties of six to ten
exposed themselves to
significantly more hazard
(pA N O VA = 0.030) than people

traveling in parties of four and
more than ten people. Thus the
risky shift, or the tendency of

larger groups to take more risks,
appears to exist for accident party
sizes between four and ten
people. Solo accident victims also
seemed to exhibit a higher level of
risk. As we saw in the previous
section, these results are robust
with respect to age, activity type
and level of training. 

So far, we’ve seen that
e x p o s u re scores are useful for
roughly approximating the risks
taken by parties in avalanche
terrain immediately prior to an
accident. But what can exposure
s c o res tell us about heuristic
traps? In the next two sections,
we’ll look at how exposure scores
vary with cues for two heuristic
traps, and we’ll look at why these
traps may have been difficult for
some avalanche victims to avoid.

Trap #1: Familiarity

The familiarity heuristic is an
unconscious rule of thumb that
we use to simplify our decisions
in familiar situations. Rather than
go through the trouble of figuring
out what behavior is appropriate
every time, we tend to rely on our
past actions in that setting as a

g u i d e .i x Most of the time, the
familiarity heuristic is re l i a b l e .
But when the hazard incre a s e s
and the setting remains the same,
this rule of thumb can become a
trap.

To determine if there was
evidence of the familiarity trap in
avalanche accidents, I compared
e x p o s u re scores of accident
parties in familiar and unfamiliar
terrain. To facilitate the
comparison, I rated each group’s
familiarity with the accident site
where it was reported or could be
credibly inferred (367 cases). Most
accidents (71%) occurred on
slopes that were very familiar to
the victims. Fewer accidents
o c c u r red on slopes that were
somewhat familiar (12%) and
unfamiliar (17%) to the victim. In
the subsequent analysis, I made
comparisons only between the
“very familiar” and “unfamiliar”
categories – the “somewhat
familiar” category showed
intermediate values that are
omitted here for clarity.

Exposure scores of all groups
showed a significant difference in
familiar terrain (pt = 0.027), with

an increase of 0.39 ± 0.35 hazard

indicators at the 95% confidence
level. The effect was most
pronounced in parties with the
highest level of training (Figure 5),
who exposed themselves to 1.9 ±
0.76 more hazard indicators in
familiar terrain. There was a
marginally significant increase in
exposure scores for groups of two
people (pt = 0.090).

The tendency of highly
trained accident victims to make
riskier decisions in familiar
terrain is disturbing. While this
g roup seemed capable of
recognizing and avoiding obvious
avalanche hazards, it appeared to
do so only when traveling in
unfamiliar terrain. In familiar
terrain, this group seemed to
suspend its ability to heed
obvious warnings and
subsequently exposed party
members to significantly more
risk. Also disturbing is the
f requency of this phenomenon:
more than four times as many
accidents happened to this group
in familiar terrain than in
unfamiliar terrain. Thus the
familiarity heuristic appeared to
be more a rule than an exception
among avalanche victims with
high levels of avalanche training.

P e rhaps highly trained
avalanche victims perc e i v e d
familiar terrain as somehow safer
than unfamiliar terrain. But was
it? Comparing victims with
advanced training to those with
basic training, we find that the
advanced group had a 21.9%
lower proportion of accidents in
familiar terrain than in unfamiliar
terrain. Assuming that both
groups visited the two types of
terrain with approximately the
same frequency, this supports the
idea that familiar terrain may in
fact have been slightly safer for
those with advanced knowledge
than for those with basic
knowledge. Certainly, an intimate
knowledge of terrain feature s ,
local avalanche history, and
snowpack structure, or the effects
of skier stabilization might have
contributed to this. But given the
high percentage of accidents that
happened in familiar terrain, it
appears that these groups greatly
o v e restimated the degree to
which familiar slopes were safer.
In the end, avalanche victims with
advanced training exposed their
parties to about the same risks as

victims with little or no training
when they were in familiar
terrain. Familiar terrain, it seems,
had the effect of negating the
safety advantages of avalanche
education in the more highly
trained victims.

Trap #2: Commitment

Once we have made a
decision, subsequent decisions are
much easier for us if we simply
maintain consistency with that
first decision. This strategy,
known as the commitment
heuristic, saves us time because
we don’t need to sift through all
the relevant information with
each new development. Instead,
we just stick to our original
assumptions about the situation

and decide accord i n g l y.x L i k e
most heuristics, the commitment
heuristic is pretty reliable, but it
becomes a trap when consistency
overrules critical new information
about an impending hazard.

To determine if there was
evidence of the consistency trap in
avalanche accidents, I compared
e x p o s u re scores of accident
parties that had either high or low
commitment to entering the path
that eventually avalanched.
Highly committed groups had a
stated goal that they were actively
pursuing or a goal they were
motivated to achieve because of
approaching darkness, timing or
other constraints (253 cases).
G roups with low commitment
were not motivated to achieve a
specific goal; the accident
typically occurred during the
course of routine re c re a t i o n a l
activities (138 cases).

Exposure scores of all groups
showed a significant diff e re n c e
when commitment was high (pt =

0.00021), with an increase of 0.49 ±
0.26 hazard indicators at the 95%
confidence level. Among different
training levels, the effect was
marginally significant for parties
with basic training (pt = 0.070) and

advanced training (pt = 0.10).

Among different party sizes, the
effect was marginally significant
for parties of three people (pt =

0.062) and significant for parties
g reater than four people (pt =

0.0026). In all these cases, the
presence of high commitment by
the accident party corresponded



to higher exposure scores. One
might argue that these differences
w e re due to some connection
between avalanche conditions
and the level of commitment
adopted by accident parties.
H o w e v e r, a comparison of
avalanche hazard ratings posted
at the time of the accidents shows
no such connection (p = 0.69 by
the Kru s k a l - Wallis or H- t e s t ) .
Thus, it appears that accident
parties who felt highly committed
to enter the path that avalanched
did in fact take more risks than
parties who were less committed.

In their book Snow Sense, Jill
Fredston and Doug Fesler (1994)
discuss the dangers of the Cow
Syndrome, or the rush to get back
to the barn, and the Lion
Syndrome, or the rush to be the
first to get to a summit or a
particular slope. Here we see the
very real results of these two
behaviors – and the incre a s e d
exposure to avalanche danger that
came hand in hand with increased
commitment to such goals. The
commitment heuristic, although it
may simplify some decisions in
avalanche terrain, off e red no
additional margin of safety to
these victims and in most cases, it
actually appears to have lead to
greater risk taking. 

In part 1 of this article, we
reviewed the basics of human
p e rception as they relate to

decision making in avalanche
terrain, and we’ve seen that the
risks taken by accident parties can
be roughly quantified using the
exposure score. We’ve also seen
that these risks were independent
of their age and, to a large extent,
the activity they were engaged in
at the time of the accident. Across
all accidents, we’ve seen that
party size was a significant factor,
with small groups (1–2 people)
and medium sized groups (6–10
people) exposing themselves to
the most avalanche hazard. We
looked at two heuristic traps: 1)
F a m i l i a r i t y, which seemed to
affect avalanche victims with the
highest levels of training, and 2)
Commitment, which had its
strongest effects in large groups
and at higher levels of training.

In part 2, we’ll look at four
heuristic traps that operate on a
social level; those based in gender,
social setting, and leadership.
We’ll also look at the cumulative
effects of all these traps, and see
which recreation groups are the
most susceptible to them. Finally,
we’ll wrap up part 2 by looking at
some of the implications of these
results for avalanche education.

Since completing his Ph.D. in mechanical
engineering, Ian McCammon’s life has
described a strange arc involving robotics,
micromachines, technical management, and
the life of a NOLS instructor. He now inhabits
the remarkable landscape that lies at the
intersection of avalanche science, engineering,

and psychology.
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i In his thought-provoking book Theory and
Reality, Peter Godfrey-Smith gives a
fascinating account of how modern
scientific knowledge has been constructed
despite the limitations of human
perception. Objectivity, he maintains, is a
misleading construct that creates an
artificial distinction between our
observations and our point of view.

ii The ability to recognize familiar patterns
and exceptions to those patterns is a
cornerstone of modern research into
human expertise. See Flin et al. (1997),
Klein (1998) or Shanteau et al (2003) for
reviews.

iii In an earlier paper, I demonstrated why
this strategy (referred to in the literature as
systematic thinking, stage processing, or
analytic decision making) is impractical
for making decisions in unstructured
environments such as avalanche terrain
(McCammon, 2001). A substantial
literature has shown that even with the
best training in these methods, people very
rarely find them practical for real-world
tasks. See Beach and Lipshitz (1993) and
Chiaken and Trope (1999) for reviews.

iv Heuristic reasoning was first explored
by cognitive scientists in the 1970s. Since
their experiments were designed to reveal
systematic errors in the process, heuristics
(and natural human reasoning as a whole)
came to be viewed by many as
fundamentally flawed. Recent findings on
real-world decisions, however, show that
heuristic reasoning is in fact a powerful
and flexible strategy in complex situations
where we lack time or expertise.
Gigerenzer et al (1999) and Chaiken and
Trope (1999) give excellent reviews of
modern research in heuristics.

v The six heuristics traps reviewed in this
study were adapted from well-known
principles of advertising and social
psychology. Aronson (1999), Pratkanis and
Aronson (2000) and Cialdini (2001)
provide in-depth overviews of these
principles and describe how they have
been exploited in advertising, public
policy, religion and other  settings.

vi Thanks to Bruce Tremper, who
suggested using a considerable rating
(rather than a high rating, as in my
previous studies) as the threshold value for
the forecast indicator. This change had the
happy result of normalizing most of the
hazard score distributions, facilitating
more robust statistical comparisons
between groups.

vii In this paper, evidence of correlation
between two variables is expressed as a
probability (p). In keeping with statistical
convention, a significant correlation is
considered to have a probability of 95% or
greater (p ≤ 0.05). In other words, there is
less than a 5% chance that a correlation
deemed to be significant is due to random
variation in the data.  Results are
considered  to be marginally significant
when 0.05 < p ≤ 0.10. Parametric tests
were judged to be valid when distributions
fell within 95% of normal symmetry and
kurtosis; otherwise, nonparametric tests
were used. The type of test used to assess
significance is shown as a subscript of the
probability or is noted in the text.

viii This finding mirrors the results of an
earlier study (McCammon, 2000). The
behavior-based definitions of training used
in this study had the effect of smoothing
out slight differences between training
categories found in earlier results.

ix This heuristic is closely related to the
well-known “availability heuristic”
originally identified by Amos Tversky and
Daniel Kahneman (1974). This heuristic
creates a tendency to base our decisions on
information that is most easily recalled.

x The commitment heuristic seems to be a
product of at least two psychological
principles. The first is cognitive
dissonance, which embodies our desire to
be and appear consistent with our words,
beliefs, attitudes and deeds. The second is
cognitive conservatism, which is our
tendency to preserve our preexisting
knowledge, beliefs and hypotheses. See
Plous (1993), Aronson (1999) or Hastie
and Dawes (2001) for detailed discussions
of these principles.
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